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Dear user,  
 
Thank you for choosing this SRA Instruments product.  
 
This manual contains all the necessary information for the correct use of your software. Should you need 
further information or if you encounter any problems, please contact our After Sales Service: 
 
 

Hotline: +33 (0)4 78 44 22 09 
E-mail : service@sra-instruments.com 

 
 
 

 

 
 

 
SRA Instruments 
210 rue des Sources 
69280 Marcy l’Etoile 
FRANCE 
 

 
Tel : +33 (0)4 78 44 29 47 
info@sra-instruments.com 
www.srainstruments.com 
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1. Introduction 
Soprane CDS is a chromatography software, more specifically dedicated to MicroGC and on-line analysis. It 
can drive several instruments and perform a wide range of calculations.  
 
Here are the available features: 

• Define a sequence of analyses using multiple streams and several methods of analysis (see chapter 
Managing methods). 

• Automate the sending of analytical methods to the different modules of the analyzer, (see chapter 
Managing analysis sequences). 

• Acquire the signals and perform the integration at the end of the analysis, (see chapter Managing analyses 
and Process, as well as Appendix II: Integration process principles) 

• Determine concentrations and other calculations, (see chapter Process) 

• Do regular calibrations, (see chapter Managing calibration sequences) 

• Archive the results, (see chapter Managing files) 

• Print or visualize them in various formats, 

• Communicate with third party applications (or automatons) to send analysis results (Managing 4-20 mA 
outputs , relay, Modbus link, ...).  

 
This manual does not describe how to configure Soprane CDS. For that, refer to the "Soprane CDS 
Configuration Guide". 
 
 

2. Use of Soprane CDS 
In most cases, Soprane CDS is provided installed. In this case, your version of Soprane CDS has been used to 
check the operation of your analyzer and you already have analysis methods, archived results, and analysis 
sequences on your hard disk. 

 

We will assume hereafter that Soprane CDS has been simply installed and configured, and that no analysis 
has been performed. 
 
Using Soprane CDS will require many steps: 
 

• First, we will have a look at the different menus, and we will check the possibility to establish a connection 
with the analyzer. 

• We will create an analysis method (see chapter Managing methods), 

• We will create an analysis sequence (see chapter Managing analysis sequences), 

• We will carry out analyses (see chapter Managing analyses), 

• From the chromatogram of an analysis, and directly, we will create an integration method and an 
identification table of the peaks (see chapter Process as well as Appendix II: Integration process 
principles), 

• We will see how to calibrate the instrument (see chapter Calibration), 

• We will program post-analytical calculations (see chapter Specific calculations), 

• We will visualize results graphically, in tendency (see chapter Managing trends), 

• We will program automatic regenerations of the columns (see chapter Automation). 

• Finally, we will consider the possibilities to reprocess the analyses and to compare chromatograms (see 
chapters Analyses results and Comparison of chromatograms). 
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2.1 Presentation of the display 

In the case of a normal opening of Soprane CDS, when launching via the application                             , the 
software initializes and displays the following main page: 
 

 
 
Soprane CDS is composed of three main menus available on the left side of the window: 
 
 
 
 
 
 
 
 
 
 
 
 
In each main menu, the most useful functions are accessible in the top bar: 
 

- Top bar of the "Analysis" menu: 
 

 

Analysis : The main menu of Soprane CDS, used daily to load methods, sequences, start 
analyses and view results. 

Process : Used to develop the processing part of the method or to process a single 
analysis. 

Logs : Used to track activities and problems on Soprane CDS. 
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- Top bar of the "Process" menu: 
 

 
 
 

2.1.1 Analysis menu 

 

 
 
 
Meaning of the icons : 
 
 
① Start          or stop          an analysis or a sequence 

② Status display          ; its color varies depending on the status  

③ Display of the real time          of the analyzer in progress 

④ Method, used for creating, editing, saving, or loading a method, setting up alarms to define the device 
and the relays used to copy a chromatograph fault or threshold alarms. These relays can work in positive 
or negative logic. The user has the possibility to group several alarms on the same relay output. 

 

⑤ Sequence, used for creating, editing, saving, or viewing a sequence 
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⑥ Calibration, used for creating, editing, saving, or viewing a calibration method. 

 
 
 
⑦ The automation button            is used to schedule a sequence, calibration, or column regeneration 

automatically. 
 
⑧ The Results button             is used to select and display the results window. 
 
 
⑨ Selection of the displayed result value 
 

 
 
By clicking on the menu, the value of the results and trends displayed will be updated according to the 
selection. 

 
⑩ Report            : displays the analysis report for the selected analysis in the results table. 
 
⑪ Trends          : Soprane CDS enables you to visualize the evolution of results or values calculated over a  

period of time. 
 

⑫ Compare          is used to open the compare and overlay analysis executable. 
 
⑬ Options  
 
      By clicking on the options menu, you can: 

• Configure pre and post analysis, and post reprocessing commands 

• Configure a specific calculation (natural gas, combustion, LPG...) 

• Configure the display of the results 

• Automatically save your results in an Excel file 

• Send results to analog outputs 

• Configure a pre-analysis event table 
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2.1.2 Reading the status 

When Soprane CDS is launched, when a new method is sent to the analyzer, before a start of analysis or 
before stopping Soprane CDS and the analyzer, you must visualize the analyzer status. Is it "READY" for the 
desired action? 
 
Moreover, the status visualization is the best way to ensure that Soprane CDS is able to interact with the 
analyzer. 
 
You can find these status indications in several places: 
 

- The status bar: 

Soprane CDS allows you to know at any time the status of the analyzer. This information is located in the 
horizontal bar at the bottom of the main screen of Soprane CDS. 

 
The information given is as follows: 

 
 

When the cursor is moved over the field corresponding to the 

analyzer, additional information on the configuration of the 

analyzer appears.   

 

When the cursor is moved over the field corresponding to the 

method, additional information on the current method appears. 

 

 

 
 

- The title bar: 

The title bar is an important element to know the status of the instrument. 
 

 
 

 
- Eye:  

The button representing an eye in the "Analysis" tab allows the status to be read. When it blinks, the status 

display is available. 

Name of the current method Status of the instrument Viewing the current configuration 

Viewing the current method Name and type of the instrument Type and name of the user 

Name of the current instrument Software help Advanced parameters 

Current calibration channel 
User management "About" display 
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 Its color changes according to the status: 

 Indicates that the status reading is not available (the configuration is not loaded). 
 
 
Indicates that the analyzer is not operational to launch an analysis. 
 
 
Indicates that the analyzer is ready to start an analysis. 
 

 
 Indicates that the analyzer is analyzing. 
 

 

- Status: 

The display shows everything about the device: number of modules, temperatures, pressures, status of the 
detectors. In the upper part of the window, it is immediately clear whether the module is operational (green 
background) or not (red background). 
 

 : Module is ready. 

 : Module is not ready. 

 

 

If an element has not reached its set point, it means that it is not ready. The text is in Orange. 

If the setpoint has been reached, the text is in Green (see window above). If the element is not activated, it 

is in Black. 
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Another simple display of the status is possible by clicking on the button               and on the button              to 
return to the graphic display. 

 

 

In both visualizations, when the mouse cursor is moved over an element in the Status part or on the visual 
part, additional indications appear such as the status, the setpoint or the current value of the element. 
 

2.1.3 Process menu 

After performing analyses and saving chromatograms, the process module is used to process or reprocess 
peaks. Three steps are necessary to obtain a result: 
 

- Integration : Defines to Soprane CDS how to integrate the peaks present on the chromatogram by 
defining the integration table. 

- Matching : Defines in Soprane CDS the molecules corresponding to each peak by defining the 
retention times in the identification table. 

- Calibration : The calibration can be divided into three steps.  
o The first one is the information of the calibration table to define to Soprane CDS what is the 

composition of each standard gas cylinder.  
o The second is the analysis of each standard gas cylinder with the method to be calibrated.  
o The last one is the association of the chromatograms obtained by analyzing each standard, 

to the calibration table. 
 
In the process menu, the different steps are accessible by the arrows: 

 

2.1.4 Logs menu 

This menu allows the display and management of logs. The application logging offers several types of files: 
 

- Action logs : it contains all the events that Soprane CDS has detected. 

This table contains the following information: 

• Date: The date of the event. 

• Profile: User profile (Administrator, Service or Operator) 

• User : Name of the user 
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• Action : Action performed 

The table columns can be sorted and filtered. The selected lines can be deleted (either by pressing the delete 
key or by clicking on the button          or by the contextual menu). 

 Events can also be archived by clicking on the icon          ; a file with today's date will be created. 

 
- Alarms log : it contains all the alarms that have been triggered. 

This table contains the following information: 

• Date : the date of the alarm. 

• Peak name : the name of the peak corresponding to the alarm. 

• Minimum : the minimum scale before the alarm is triggered. 

• Maximum : the maximum scale before the alarm is triggered. 

• Value : the value when the alarm is triggered. 

• Device : the name of the device assigned to the alarm. 

 The table columns can be sorted and filtered. The selected lines can be deleted (either by pressing the delete 
key or by clicking on the button          or by the contextual menu). 

 Events can also be archived by clicking on the icon        ; a file with today's date will be created. 

 

- Error log : it contains all the errors that have been detected. 

This information is intended for developers to locate errors during a crash. 

 

- Calibration history: it contains all calibrations performed with Soprane CDS. 

 
 

Note: The two small icons                allow you to view the calibration results and the calibration report (see 
sections Reference calibration and Calibration report).  
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2.1.5 About display 

In the title bar, the icon        allows to visualize the version of the Soprane CDS software and its specific 
checksum. 

 
 

2.2 Managing methods 

Soprane CDS offers the possibility to directly access an analysis method to visualize and modify it. 
 

2.2.1 The operating conditions 

The display allows viewing, editing, or modifying all the parameters of the analysis method. 
 
To access the methods, go to the Analysis tab, click on the following button, and choose from the drop-down 
menu what you wish to do: 
 

 
 

The setup program Configuration                was used to configure Soprane CDS according to the type of 
analyzer used. 
 
As these devices are different, the analysis methods will also be different. 
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Below are the different parameters accessible in the method; 2 types of data are to be provided: 

- Check boxes. They correspond to ON/OFF states. 
- Numerical values. 

 
Common parameters: 

- Inlet heated: Tube temperature from sample inlet to injectors. 

- Run time: Analysis time / chromatogram acquisition time. 

- Sampling time: Sample pumping time before injection. 

- Used: Always keep checked. 

- Injector heating: Injector temperature (5°C above heated inlet temperature). 

- Column heating: To be adjusted according to the column and the application. 

- Injection time: Changes the volume of sample injected into the column. Set between 40 and 200 ms. 

- BackFlush time: To be adjusted according to the application. (See Appendix IV: Setting the backflush 
time). 

- Column pressure: To be adjusted according to the application. Generally between 20 and 30 PSI. 

- Detector: Status of the detector. Check to turn it on. 

 

 
 
 

By clicking on "   Advanced parameters ", a 2nd window will open, where you can fill in the parameters 
below: 
 
Advanced parameters: 

- Stabilization temperature time: Latency time before the MicroGC switches to the "ready" state. 

- Continuous flow: If this box is checked, the pump is disabled since the sample is flowing 
"continuously" in the injection loop, continuous flow can be enabled only in the Soprane CDS 
configuration. 

- Minimal sampling time : Minimum sampling time. 

- Pressure checking range: Sensitivity to define that the pressure has reached its set point 

- Range: Always set to "Auto". 
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- Control Max TCD Temp: TCD temperature control; if the TCD heats up due to a bad configuration of 
the carrier gases, for example, a safety device switches off the TCD. 

- Invert signal: Inverts the signal when using Argon or Nitrogen carrier gas. 

- Prog. press. Init. time: Programs the pressure if needed. 

- Ramp: Indicates the pressure ramp (if the ramp is used). 

- Final pressure: Indicates the expected final pressure (if the ramp is used). 

 

 
 
Click on "Save" and then on "Save as" and give the name "Analysis" to this method. 
 

2.2.2 Loading an analytical method 

The loading of a method is accessible in the "Analysis" tab, by clicking on "Method" and selecting :  

 

 

 
 
To confirm the selection of the configuration simply press the Confirm button and the method will be loaded. 
 

2.2.3 The 4 useful methods 

Whatever the type of instrument you use, it is necessary to create the 4 following methods: 
 

✓ Start/Stop method: only carrier gases circulate in the analyzer, but the columns are not heated, the 
temperatures are set below 50°C. This method will then be used when starting and shutting down 
the instrument. 

✓ Standby method: the carrier gases circulate; the columns are heated but the detectors are switched 
off. This method will be used after the Start/Stop method and also when one wants to let the analyzer 
under conditions (Pressure and temperature) stabilized awaiting analysis. 
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✓ Analysis method: the carrier gases circulate; the columns are heated, and the detectors are switched 

on.  
 

✓ Bake-out method: it is a method used to regenerate columns (see chapter Column bake out). The 
temperature is higher, the pressure slightly increased and the detectors are switched off. 
 

Before switching off the analyzer, and for security reasons concerning columns, it is better to send the 
Start/Stop method and to wait that the columns reach a temperature below 50°C. 
 

2.2.4 Sending "Standby" method automatically 

An "Administrator" can configure the automatic sending of a "Standby" method. 
 
To do this, log in as Administrator, select the "User" menu, click on "User settings" and select the "Method" 
menu. 
 
There are two choices:  

- Send the method after the end of the analyses 
- Send the method after an inactivity time to be defined 

 

 
 

2.3 Managing analysis sequences 

Before you can create a sequence, you must first have created an analysis method (see chapter Managing 
methods). 
 
We want to perform cyclic analyses. It is thus necessary to define which streams will be analyzed, which 
analysis method will be used for that, how long it will be necessary to wait before injection, … 

 

We suppose that the chromatograph allows the analysis of several streams. These streams can be selected 
by campaign (only analyses of one stream are carried out) or sequentially, all streams having the same 
analysis frequency or some being more important than others. 
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To access to the sequence edition, go to the Analysis tab and click on the Sequence button. 
 

 
 

 
By clicking on "Edit an analysis sequence", the following window appears:  
 

 
 
In this table, it is possible to define the analyses by giving them a name, to select an analysis method (each 
box is a list field displaying all the methods), to indicate which stream is concerned (another list field) and to 
specify the minimum sampling time before the injection and the number of repetitions of this step. 
 
Additional information about the sample can be added. These values are the name of the sample, its 
identifier, and a comment if necessary. 
 
What is the purge duration? 

The analysis method already includes a sweeping time of the injection loop, which corresponds to the pump 
management. Indeed, before injecting, it is necessary to circulate the sample in the injection loop, which may 
require a pump to suck the sample. 
The duration programmed here is before and does not concern the injection itself but the circulation of the 
sample. It corresponds to the selection of the sample. 
When the stream selection valve is switched, it is necessary to sweep the "residues" of the previous stream 
so that what will be injected will be representative of the sample to be analyzed, which requires a more or 
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less long time, depending on the sample, its characteristics, the flow rate and the volume between the sample 
selection valve and the injection valve. 
 
The programmed value (value in seconds) will allow Soprane CDS to anticipate the next analysis and to select 
the next stream in time for the scan to be sufficient. 

 

Note : 
An analytical sequence can of course include the reference of a stream defined elsewhere as being used for 
calibration. It should be kept in mind that this is an analytical sequence, which means that these standards 
will then be analyzed like any other sample and will result in the calculation of concentrations. 

 

2.4 Managing calibration sequences 

As for an analysis sequence, before you can create a calibration sequence you must first have created an 
analysis method (see chapter Managing methods). 

 

To access the editing of a calibration sequence, go to the Analysis tab, click on the Calibration button, and 
select "Edit a calibration ". 
 

 
 
The following window appears: 
 

 
 
In this table, it is possible to define the analyses by giving them a name, to select an analysis method (each 
box is a list field displaying all the methods), to indicate which stream is concerned (another list field) and to 
specify the minimum sampling time before the injection and the number of repetitions of this step. 
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These are the same parameters as when editing an analysis sequence (see chapter Managing analysis 
sequences), it is also necessary to add the reference of a stream defined elsewhere as being used for 
calibration. Keep in mind that this is an analysis sequence, which means that these standards will be analyzed 
like any other sample and will result in the calculation of concentrations. The type of calibration should also 
be filled in. 
 
Additional information about the sample can be added. These values are the name of the sample, its 
identifier, and a comment if necessary. The sub-folder can be indicated, and an option must be ticked by 
clicking on the settings button (hammer button at top right of window). 

2.5 Automation 

By clicking on the button                 the following menu is displayed: 
 

 
 

2.5.1 Column bake out 

By clicking on "Bake out", the configuration of this bake out is possible. 
 
Selecting the drop-down menu offers several possibilities: 
 

 
 

 
Indeed, there are several ways to proceed with the bake out: 

- Now: It is possible to stop the analyses and request an immediate bake out by selecting "Now" 

- After the end of each sequence: Program this regeneration to take place a little later by selecting 
"After the end of each sequence". 

- Continuous runs: Schedule this regeneration to occur on a specific date when Soprane CDS is in 
continuous analysis. 
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- Delayed: Schedule this regeneration to take place on a specific date. 
 

Below the type of window that appears: 
 

 
 

 
The bake out requires different parameters (higher column temperature, detector OFF) than those used for 
analysis, therefore you should indicate a bake out duration and the name of a method to be used for 
regeneration. 
 
The post bake out is used to reduce the temperature after the regeneration. A post regeneration method 
must therefore be indicated. This post regeneration method is similar to the methods used for analysis but 
with the detectors OFF. Such a regeneration can be carried out during the night or weekend for example, 
which ensures the user to have a device ready for use without loss of time. 
 
In the "Delayed" mode, a check box "Continue analyses" is present; if it is checked and an analysis was in 
progress, the analyses will continue after the regeneration cycle. 
 
For the "Continuous runs" and "Delayed" modes you must enter the date and time of the next bake out and 
the number of days between two successive regenerations (0 if only one regeneration is to be carried out). 
 
Note: The post-regeneration method can then be used as an end-of-sequence method because it enables a 
method to be loaded without performing any analyses. 
If the regeneration time is set to zero, the regeneration method is not loaded and only the post-regeneration 
is loaded. 

 

2.5.2 Programming a sequence 

By clicking on "Sequence" in the Automation drop-down menu, the following window opens: 
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Clicking on             will add a sequence for which you must fill in: 
 

- the date you want the sequence to take place 
- the frequency, determined by the interval in hours, at which you want it to take place, if applicable 
- the name of this sequence 

 
Click on " Confirm " to save the programming. 
 
Note: It is possible to change the format of the interval between "hours" and "days"; to do this, click on the 
configuration button at the top right of the window and change the format. 
 

2.5.3 Programming a calibration 

By clicking on "Calibration" in the Automation drop-down menu, the following window opens: 
 

 
 

 
In order for the programming of a calibration to be detected, you must first activate it by checking "Enable"; 
if it is deactivated the calibration will not take place. 
 
Once activated, the date, time and name of the calibration sequence can be entered. 
 
The selected calibration will be performed at the date and time indicated, with a frequency determined by 
the number of interval days. 
 
Calibration programming will only be performed when the analysis is started in automatic operation. 
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2.6 Managing analyses 

The "Start" button           in the "Analysis" tab is used to start the analyses/sequences. 

When such a request is made, Soprane CDS sends the analysis method, and the analysis starts as soon as the 
chromatograph is stabilized under the required operating conditions. 
 
In the same way, stopping a cycle of analyses can be requested by the button symbolizing a STOP panel. For 
security reasons, a dialog box allows to confirm (or not) the request and specifies that the effective stop will 
occur at the end of the current analysis. 
 
Three modes of analysis are possible: 

• Analysis : Launch a defined number of analyses with the same method (see § Starting an analysis). 

• Sequence : Launch an analyses sequence (see § Starting a sequence). 

• Calibration : Launch a calibration sequence (see § Starting a calibration). 
 

2.6.1 Starting an analysis 

 

 
 

Select the "Analysis" mode then: 

- Define the number of analyses to launch. If the box "Continuous ?" is checked, the analyses will be 
launched infinitely until manual stop by clicking on the "Stop" button. 

- Define the name of the analysis series. This will be the name under which the results will be saved, 
incremented by a number. 

- Choose the method. 

- By default, the analysis results files are saved in "C → Soprane II → Analysis → Analyzer Name ". To 
create a sub-folder, enter a sub-folder name in 

. 

- Set a time interval between two injections. 

- Click on "Confirm". 
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Notes:  
- The "Sample information" is optional. 
- The "Wait for external start" box is used if the MicroGC has to wait for a start from another instrument 

to start the analyses. 

To display these parameters, click on the configuration button at the top right of the window. 
 

2.6.2 Starting a sequence 

We suppose that the chromatograph allows the analysis of several streams. These streams can be selected 
by campaign (only analyses of one stream are carried out) or sequentially, all streams having the same 
analysis frequency, or some being more important than others. 
 
An analyses sequence may of course include the reference of a stream defined elsewhere as being used for 
calibration. It should be kept in mind that this is a sequence of analyses, which means that these standards 
will be then analyzed as any other samples and will lead to calculation of concentrations. 
 

 
 

Select the "Sequence" mode then: 

- Define the number of sequences to launch. If the box "Continuous ?" is checked, the sequences will 
be launched infinitely until manual stop by clicking on the "Stop" button. 

- Define the name of the sequence.  

- The subfolders can be configured directly in the method, otherwise they can be defined by 
unchecking "Keep subfolders defined in the sequence". 

- Set a time interval between two sequences. 

- Click on "Confirm". 
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Notes:  
- The "Sample information" is optional. 
- The "Wait for external start" box is used if the MicroGC has to wait for a start from another instrument 

to start the analyses. 

To display these parameters, click on the configuration button at the top right of the window. 

 

2.6.3 Starting a calibration 

Unlike a sequence of analyses, at the end of an analysis, the standards are analyzed and give rise to the 
calculation of concentrations. 
 

 
 
Select the "Calibration" mode then: 

- Define the number of sequences to launch.  

- Define the name of the calibration.  

- The subfolders can be configured directly in the method, otherwise they can be defined by 
unchecking "Keep subfolders defined in the sequence". 

- Set a time interval between two injections. 

- Click on "Confirm". 
 
Notes:  

- The "Sample information" is optional. 
- The "Wait for external start" box is used if the MicroGC has to wait for a start from another instrument 

to start the analyses. 

To display these parameters, click on the configuration button at the top right of the window. 
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2.7 Events table  

Soprane CDS allows to control various commands before and after injection such as auxiliary pump activation, 
stream selection. These commands are accessible via the "Options > Events table " menu. 
 

 
 
 

For each event step, you must indicate: 

• The starting time of the event 

• The command : 
o Auxiliary command 
o Change stream 
o Select the default stream 
o Custom message 
o Read analog input 
o Threshold of the analog input min 
o Threshold of the analog input max 
o Injection (starts the analysis) 
o External start (starts the analysis while waiting for a signal from another system) 
o Waiting for "Ready" (waiting for the logic inputs to be in the ready state) 
o Instrument (instrument special command) 

• The command value (could be different if you change the command type) 
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Soprane CDS will automatically start the analysis at the end of the events table. 
 
When you have finished configuring the events table, save it. 
 

2.8 Analyses results 

In normal operation, Soprane CDS provides simultaneous viewing of multiple analysis windows. 
 
These 3 windows display the results of all the analyses, the selected analysis, and the trends. These windows 
can be resized, minimized, or restored. 
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➢ Description of the menus 
 
The "Results" menu enables you to perform certain actions depending on the selection of the analyses in the 
analysis table, the same actions are possible by right-clicking on the analysis results table (For more details, 
see the section Quick actions).  
 

 
 
The "Trends" menu offers the possibility to add new trends and to configure them (see chapter Managing 
trends).  
 
The last menu "Options" offers the possibility to configure the nature and position of the windows. They can 
be memorized so that Soprane CDS can restore the display at each program launch. 
 

➢ Description of the different display modes 
 
The values in the tables and the trends are displayed in only one mode at a time. To change the mode, select 
it from the list in the top center of the window. 
 
Here are the different display modes: 

• The Results table mode displays all analyses with the results at the end of the injection. 

• The Reprocess mode displays all the analyses that have been reprocessed. 

• The Calibration mode displays all analyses that have been calibrated by reprocessing. 
 

➢ Description of the different results to be displayed 
 
The main table and the trends focus on one type of result only. You can change the result to be displayed by 
selecting it from the list at the top right of the window. 

 

Here are the different values that can be displayed: 

• Concentration 

• Normalized concentration  

• Retention time (in seconds) 

• Peak area 

• Peak height 
 

2.8.1 Series of analyses 

The "Analysis series" window offers the possibility to see the results of analyses, reprocessing or calibration. 
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The top of this window presents several buttons  . (see chapter Appendix VI: Exporting Data 
for more details). 
 
It is possible to open the processing tool or the comparison tool but also to reprocess or re-calibrate analyzes 
without hindering the sequence on-going. If only one analysis is selected, the analysis report can be consulted 
as well as the analysis conditions (method, analyzer configuration and reference calibration). 
To do this, simply select one (or several) analyze(s) at the same time in the table, right-click (or via the Results 
menu) (For more details, see section Quick actions). 
 

 



SOPRANE CDS User manual for MicroGC – Version 2.1 

 

 
Page 31 / 138 

The table shows all the existing peaks in the table of components of the method, as well as the minimum, 
maximum, average value, and RSD in % (Coefficient of variation). 
 
The minimum values are displayed in green and the maximum ones in red. 
 
The analysis selected in this table will be indicated by a vertical bar in the trend chart (See chapter Managing 
trends) and will modify the information contained in the results table. 
 
The table contains by default all the series of analyzes carried out, it is possible to perform filtering (see 
Appendix V: Filtering Data). 
 
Note: the number of results displayed in the "Results" table is by default 1 rotating month and 1000 results. 
These values can be modified by logging in as an Administrator (see chapter User identification), selecting the 
"User" menu and clicking on "User parameters" then on "Analyses". 
 

2.8.2 Results of an analysis 

The following table shows the results of the analysis selected in the analysis series table. 
 
The title of the table indicates the analysis name and the analytical method used. 
 

 
 
The displayed values are: 

• Peak name 

• Retention time 

• Area 

• Raw Concentration 

• Normalized Concentration 

• Unit 

• Name of Peak Group 
 
The peak selected in this table will highlight the peak in the trend graph (see chapter Managing trends). 
 

The top of this window presents several buttons  . (See Appendix VI: Exporting Data for more 
details). 
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The table contains by default all the series of analyzes carried out, it is possible to perform filtering (see 
Appendix V: Filtering Data). 
 

2.8.3 Batch reprocessing 

Batch reprocessing consists in performing again integration calculations, identification, and post-analysis 
calculations for several analyzes at a time. Once the operation has been completed, the reprocessing table 
will display the analyzes with the updated results values. The trend window is also updated. 
 

 
 
The first step consists in selecting the analyzes to be reprocessed, then right click on the analyzes and click 
on Reprocessing (or with the menu Results> Reprocessing). 
Once the reprocessing has been requested, a window will appear proposing you to select an integration 
method. 
 
Once the method has been chosen, each of the analyzes will be integrated with the indicated method. The 
reprocessing table and the trend chart will be updated. 
 
Note: 
If an analysis has been updated in the processing part (see chapter Process), the results of the table are 
automatically updated; there will be no need to re-process to update the values. 
 

2.8.4 Calibration by reprocessing 

Calibration by reprocessing consists of performing the integration, identification, calibration, and post-
analysis calculations for several analyses at once. Once the operation is completed, the calibration table will 
display the analyses with updated result values. The trend window is also updated. 
 

 
 
The first step consists in selecting the analyses to calibrate, then right-click on the analyses and click on 
Calibration by reprocessing (or with the menu Results > Calibration by reprocessing). 
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Once the calibration by reprocessing has been requested, the following window will appear, proposing you 
to select an integration method and for each of the selected analyses, to choose the calibration level and 
the type of calibration to be performed. 
 

 
 

 
The different types of calibration are: 

• Blank : The analysis is defined as a blank to be ignored. This allows to rinse and wait for stabilization 
after passing a new standard. 

• Replace : This analysis replaces everything known for this level and is therefore the first measure of a 
possible series that will be averaged. 

• Average : This analysis is used to average the known data for this level, so that each measure keeps the 
same importance. 

• Weighted : This analysis is used to average the known data for this level, so that each analysis counts as 
much as all previous ones. 

 
Once validated, each of the analyses will be calibrated with the requested parameters and the indicated 
method. The calibration table and the trend chart will be updated. 
 
For more information about calibration, see chapter Calibration. 
 
Note: 
If an analysis has been updated in the processing part (see chapter Process), the results of the table are 
automatically updated; there will be no need to repeat a calibration by reprocessing to update the values. 
 

2.8.5 Quick actions  

Quick actions can be accessed either through the Results menu or by right-clicking on the results table. 
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The different operations are: 

• Show the chromatogram : Opens the chromatogram with the integration parameters in another window 
(the shortcut is a double click on the result line) (If multiple results are selected, the chromatograms will 
be displayed side by side) 

• Process : Loads the selected analysis into the processing part. (Available only if a single analysis is selected, 
see section Process) 

• Batch Processing : Retrieves each selected analysis with a specified method. (See section Batch 
reprocessing). 

• Calibration by reprocessing : Calibrates all the analyses selected with a specified method. (See section 
Calibration by reprocessing). 

• Compare : Opens the analysis comparison tool (See chapter Comparison of chromatograms). 

• Report : Displays the different choices of reports (Available only if a single analysis is selected) 
o Analysis report : Displays the analysis report (see chapter Reports)  
o Calibration report : Displays the calibration report (if a calibration has been done) (see chapter 

Calibration report) 

• Analysis conditions : Available only if a single analysis is selected; here are the different possible 
operations: 
o Displays the injection method parameters. 
o Displays the analyzer configuration during injection. 
o Displays the calibration reference (see chapter Reference calibration). 

 

2.9 Process  

As mentioned in § Process menu, it is necessary to process the chromatograms once they have been 
recorded. This is done from the Process menu in 3 steps: 
 

 
 
To understand how to perform processing correctly and the parameters that influence it, the principles of 
integration, identification and calibration are detailed in Appendix II: Integration process principles. 
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2.9.1 Integration 

The integration defines in Soprane CDS how to integrate the peaks present on the chromatogram by defining 
the integration table. 
 
The chromatogram of the selected analysis appears. Click on the "Integration" arrow. The "Integration 
parameters" table appears: 
 

 

The "Integration Parameters" are used to define how to integrate the peaks on the chromatogram.  
In the "Integration Parameters" table, a row corresponds to an integration parameter. For each line, it is 
necessary to define the "Time" from which the parameter must be applied until the end of the chromatogram 
or the definition of another similar parameter, the "Type" of integration parameter to be applied and its 
"Value".  
 
The main integration parameters are: 

- "Peak start slope" : defines from which slope the peak begins. A slope greater than this value will 
trigger the start of peak integration.  

- "Minimal height reject" : defines the minimum height for a valid peak, can be useful to eliminate 
peaks due to background noise. 

- "Minimal area reject" : defines the minimum area for a valid peak, can be useful to eliminate peaks 
due to background noise. 
 

In most of the cases, these parameters are enough to integrate correctly all the peaks. 
 

• If an integration parameter is added or modified, click on   to apply the change. 
 

• When the peaks of interest are correctly integrated, save the method with:                                                           
 

• If the MicroGC has several modules, it is necessary to define the integration parameters for each module.  
 

 Select the module with: 
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Notes : 

- A "peak start slope" of 0.01 µV/s and "height" and "area" rejects of 1 work in most cases. 

- Two "Peak detection" events, the first unchecked and the second checked, allow to define a zone 
where integration is not done. This can be useful to eliminate a zone where the signal is not stable 
and disturbs the integration of peaks of interest, at the beginning of the chromatogram for example. 

 

2.9.2 Matching 

The matching defines in Soprane CDS the molecules corresponding to each peak by defining the retention 
times in the identification table. 
 
Click on the "Identification" arrow. The "Peak Identification" table appears: 
 

 
 

Click on the button:  
 
All integrated peaks are automatically added to the "Peak identification" table. 
 
 Then: 

- Delete useless peaks with:   

- Change the "Peak name". 

- Do the same for all modules with:   

- Apply the changes with            and save the method with:  

 

2.9.3 Calibration 

Calibration can be performed in different ways. The most general technique presented here is calibration by 
reprocessing. Calibration by reprocessing can be divided into three steps: 
 

- Step 1: Fill in the calibration table to define to Soprane CDS what is the composition of each standard 
gas cylinder. 

- Step 2: Analysis of each standard gas cylinder with the method to be calibrated. 
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- Step 3: Association of chromatograms obtained to the calibration table. 
 
Since calibration is an important part to obtain accurate results and its understanding is sometimes complex, 
a concrete example will be discussed in this section. 
 

1) First step 
 
Click on the "Calibration" arrow: 
 

 
 

In the "Peak identification" table, define for each molecule: 

- The unit used for calibration and reporting. 
- The type of calibration curve. 

 
Select the first molecule in the "Peak identification" table (N2 for example). The "Calibration" table for the 
selected molecule appears below:  
 

 

To avoid making mistakes, the following rule is generally defined: 
 

One standard gas cylinder = One level  
 

Create the same number of lines, called "Level", as the number of standard gas cylinders used for calibration, 
whether or not the selected molecule is present in the cylinders. 
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For each level, define: 
 

- The "Amount" or concentration of the molecule in the cylinder. Be careful to respect the unit defined 
in the "Peak identification" table.  

- If the molecule is not present in the cylinder corresponding to this level, uncheck "Level used".  
 
Example: 
 
We want to analyze nitrogen and methane on module A (MS5A column). Two standard gas cylinders are used 
for calibration: 

- An air cylinder with composition: 80% N2 and no CH4 
- A natural gas cylinder with composition: 1,60% N2 and 94,43% CH4  

 
In the "Peak identification" table, we define the unit "%" and the curve type "linear through 0": 
 

 
 
For N2, we create a calibration table with 2 levels, and we check "Level used" for the two levels because 
nitrogen is present in both cylinders. We enter the contents of both cylinders:  
 

 
 
For CH4, we create a calibration table with 2 levels and uncheck "Level used" for the first level because 
methane is only present in the second cylinder: 
 

 
 
 

2) Second step 
 
The aim is to analyze the different cylinders of standard gas using the method to be calibrated. A good 
practice is to analyze the same bottle several times and then check that the areas of the peaks are repeatable. 
 
Example : 
 
We perform 3 analyses of each standard gas cylinder. For the analysis of the air cylinder, we give the name 
"Air lvl1" to the series of analyses. For the analyses of the natural gas cylinder, we give the name "Natural 
Gas Mixture lvl2" to the series of analyses.  
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3) Third step 
 
Finally, the chromatograms obtained in the second step must be associated with the calibration table defined 
in the first step. A chromatogram corresponds to a cylinder and therefore to a level. 
 
Return to the "Analysis" menu and select the standard gas cylinder analyses in the "Results" table: 
 

 
 

Right-click on the mouse and select "Calibration by reprocessing". 
 
The "Calibration" window appears: 
 

 
 

- Select the method to calibrate. 

- For each analysis, define the corresponding level. 

- For the first repetition of a level, select "Replace" as "Calibration Type". The old calibration of this 

level will be deleted and updated. 

- For other repetitions of the same level, select "Average".  

- Click on:  

Example: 
 
We obtain the following table: 
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The N2 and CH4 peaks are reintegrated for the 3 natural gas analyses. The average area of the N2 and CH4 
peaks is calculated. The average area of N2 peaks is associated with 1.6% and the mean surface area of CH4 
peaks is associated with 94.43 % (level 2). 
 
Then the N2 peaks are reintegrated for the 3 air analyses. The average area of the N2 peaks is calculated. The 
average area of the N2 peaks is associated with 80 % (level 1). As the checkbox "Level used" is unchecked for 
CH4 in level 1, if a CH4 peak is integrated (pollution, memory effect...), the peak area will not be considered 
to draw the calibration line for CH4, which avoids errors. 
 
To see the resulting calibration curves: 
 

- Go to the "Process" menu and click on the "Calibration" arrow.  
- Select a molecule. 

 
The "area" for each level and the "Calibration Curve" have been updated. 
 

 
 

From this moment, if an analysis is started with the "Analysis" method, the chromatogram obtained will be 
automatically processed with the integration method and the identification table previously developed and 
the result in concentration will be linked to the calibration previously performed. 

2.10 Managing alarms 

Different types of alarm can be configured: 

- Constituents, the monitored variable is usually the raw or normalized concentration 

- Result of a calculation, for example the value of the SCV 

- Sum of the compounds, for example the sum of the concentrations 

- Delta of the retention time on a compound 

- An analog value, for example the pressure of the sample inlet 
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Go to "Method / Alarm". For each alarm, you must indicate: 

• The alarm value (described above) 

• The variable used for this default (raw concentration, normalized concentration, retention time, 
peak area or height, calculation result, compound...). 

• The stream on which this constituent is monitored. 

• The low threshold value. 

• The high threshold value. 

• The alarm to associate. 

• The action to execute in case of default (optional). 

• The type of notification in case of error   

• Indication if the alarm is "metrology" 
 

 
 

 

2.11 Managing trends  

2.11.1 Description 

In normal operation, Soprane CDS displays simultaneously 6 windows related to the analyses and enables to 
visualize the evolution of the values or the calculated values over a period of time. 
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These windows enable the visualization of the chromatogram, the results, the current analysis sequence, and 
the trends. These windows can be resized, minimized, or restored. 

 

Peaks, calculations, and analog inputs can be viewed independently of each other. Access to trend sheets is 
prohibited until the user has scheduled a minimum of data concerning the peaks identified in the analysis 
and the post-analytical calculations. 
The identification of a peak is done by its name and the module. If the name of a peak is changed, it will no 
longer be recognized on the trend sheets. So, for example, I integrate a nitrogen peak whose name is N2 and 
I use the trend viewing of its concentration value. 
I change the name of this peak from N2 to NITROGEN in the constituent table. It is necessary for me to rewrite 
the demand for visualization in trend under this new name. 

 

The horizontal axis represents the injection date of the analysis, the vertical axis corresponds to the value 
you have chosen to display. To change the value to display, select the Results menu, the following pop-up 
window will appear. 

 

 
 
On the graph, a point represents an analysis value, the red vertical bar represents the location of the analysis 
selected in the analysis series table (see chapter Series of analyses). If you click on an analysis point, the 
analysis selected in the analysis series table will be changed. 
 
A tooltip appears when the cursor is over a trend point. 
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2.11.2 Trends configuration 

 
The button           is used to set the trends to be displayed. 

 

Several types of values can be visualized:  

- Compounds 
- Analog inputs 
- Natural gas calculations 
- Combustion calculations   
- LPG calculations  

 
Note : 
The "Save window positions" option in the menu does not mean that Soprane CDS will save the state in which 
you exit the program. What is saved is the nature and position of the windows at the time of the request. 
When Soprane CDS is started again, the windows will automatically be reopened and repositioned to their 
location. 
 

2.12 Managing 4-20 mA outputs  

The MicroGC can be equipped with several 4-20 mA outputs. 
These outputs enable, after scaling, the transmission of a value related to a constituent (surface area, raw 
concentration, normalized concentration, or mass concentration) or the value of a calculation result (this is 
then the first calculation set). 
 

 
 

2.13 Launching external programs 

Soprane CDS offers the possibility to launch a program before/after the analysis via the "Options > 
Commands" menu. 
 
It is possible to launch a program before the injection and to wait or not the end of the execution of this 
program. If this option is unchecked, the injection cycle goes on and the pre-run program can lead to a Start 
of the MicroGC. If this option is checked, the injection cycle is stopped for the whole duration of the pre-run 
program (eg external pump).  
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2.14 Comparison of chromatograms 

The comparison module is used to visualize and compare several chromatograms. This enables to follow the 
evolution of a phenomenon during the analyzes, possibly the degradation of the columns. 
 
The comparison module is a software in which one opens documents, each document consisting of 2 to 64 
analyses. 
 
When loading, the main screen is displayed: 
 

 
 
Two choices are proposed, the first one is to start from an empty window and add the analyses you want and 
the second one is to load a previously saved analysis comparison file. 

 

When the loading has been enabled, all the chromatograms are visualized simultaneously on the displayed 
document. 
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Each chromatogram has its own color, which helps to differentiate them. The name of this chromatogram is 
displayed in the legend of the graph. 

 

 

 

 

 

By passing the cursor over one of these analyses, the curve will be 
bolded to better differentiate it from the others. 

 

To allow graphical operations on some analyses, you must select 
them. The icon         indicates that the analysis allows these operations 
on this analysis while the icon         indicates that any operation will 
be ignored on this analysis. 

 

 To do not display an analysis, simply click on the icon            the 
analysis will be hidden (a hidden analysis will have the following icon           
          ) 

 

 
 
The module bar enables the display of the chromatograms of each module that equip the analyzer with a 
single mouse click on the corresponding letter A to D. 

 

Each document can be saved and reopened later. 

 

The zoom tool is also a way to properly view the analyses (see Appendix I: Chart for more details). 
 
The palette allows general operations concerning a chromatogram or involving two chromatograms. 
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For a general operation (zoom, for example), just click on the icon of the tool to make it active. 
 
An operation on a chromatogram (displacement, stretching, scaling or first derivative) is also immediate: the 
tool is first selected and then the chromatogram to which the operation is to be applied is "captured". 
 
An operation involving 2 chromatograms is carried out in 3 steps: the chromatograms are first selected in the 
legend, then the tool is selected and then a click on the graph will apply the operation. 
 

2.15 Reference calibration 

The reference calibration is the last calibration used to obtain the current results. It is available in several 
ways. 
The first is from the results table (or reprocessing/calibration). Select a single analysis and right click. Expand 
"Analysis Conditions" and select "Reference Calibration". 

Free moving 
Sum 

Zooming tool 

Vertical moving 

Derivative 

Horizontal stretching 

Smoothing 
Vertical stretching 

Ratio 

Horizontal moving 

Difference 

Free stretching 



SOPRANE CDS User manual for MicroGC – Version 2.1 

 

 
Page 47 / 138 

 

 
 
The second way is from the Process tab. Select the "Calibration" menu and click on "Reference Calibration". 
 
On the first tab, a table of results will be displayed: 

 
 

On the second tab, a calibration graph for all peaks will be displayed: 
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3. Reports 

3.1 Analysis report 

The "Calculation" section allows you to define all the reports that you may need at the end of an analysis. 
These reports can be displayed or printed. 
 

 
 
The report is largely configurable; we can set the report visualization as well as its content. 

Set the report display: 

• : Print 

• : Copy the active selection 

• : Zoom in and zoom out 

• : View full size report 

• : View report based on width 

• : Show entire page 

• : View Report on Two Pages 
 
 Set the report content:  

•        : Edit sample information 
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•            : Report configuration 

 

There are several parts in the report: the chromatogram, the integration parameters, the components table, 

and the analysis method and specific calculation. 

Each of these parts can be visible or not, and their titles are modifiable. 

 

•  : Change headers and footers 
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By clicking on the icon  a window asks to choose an image to replace the existing one. 

If the field is empty, the default images are added. 

•  Change the report orientation (Landscape or Portrait) 

•  Change columns in tables 
 
If in most of the cases we are satisfied with the columns constituent name, retention time, peak area, peak 

height and concentration, all variables, and their corresponding column, that a user would need may be 

selected. 

Colonnes de la méthode : 
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Colonnes des résultats : 

 
 

•  Automatically fill in a Word document (see chapter Customized report) 

•  Refresh the report 

•   It is possible to view the active module, but also to have a single report for all the selected 
modules. 

 

NOTE: The visible part of the chromatogram corresponds to the zoom of the chromatogram in the 
"Integration or Identification" part. 

3.2 Customized report 

Soprane CDS offers the possibility to create your customized report from a Word document template. 
 
1. Create a Word document template, with all the information you want to be presented. This document 

is a normal Word file that could include text, pictures, graphics … 

2. You must fill this document with keywords (see the list of keywords after the example). 

3. Soprane CDS will read the document and check if the document has some keywords and will replace 
each keyword by the desired value. 

 
Here's an example of a Word document template: 
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Words between brackets are keywords; these keywords will be replaced by Soprane CDS with the expected 
result values. 
 
Here's an example of the result file: 
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Page 2: 
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Page 3: 

 
 
 
The only thing to know is which keywords to use, here's the list of all keywords: 
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1. Image keywords 

 

[Method] : Import the analytical method  
[Configuration] : Import the instrument configuration 

[ResultTable] : Import the analysis result table 

[Chromatogram{moduleIndicator}]: Import the chromatogram according to the module indicator number 
(example [Chromatogram1] for the module A) 

 

2. Text keywords 

 

//Global values 
[DateNow]: Write the date of the report generation 

[Software] : Write the software used with the current version 

//Instrument settings 
[InstrumentSN] : Write the instrument serial number 
[NbPump] : Write the number of pumps installed 

[NbModules] : Write the number of installed modules 
[InstrumentType] : Write the instrument type (example CP490, M3000 Lan...) 

 

// Global Method 

[NbRuns] : Write the number of runs made with the current analysis method 

[TotalRunTime] : Write the total run time in seconds made with the current analysis method 

[LastRun] : Write the last injection date made with the current analysis method 

//Result 
[AnalysisDate] : Write the analysis injection date 

[AnalysisName] : Write the analysis name 

[AnalysisSerie]: Write the series name 

[AnalysisMethod] : Write the analytical method name 

[AnalysisPath] : Write the path of the result file 

[AnalyzerName] : Write the analyzer name 

[SampleType] : Write the sample type (Blank, Sample, Standard) 
[CalibrationLevel] : Write the calibration level 
[Stream] : Write the analyzed stream 

 

//Module configuration 

[ModuleSN{moduleIndicator}] : Write the module serial number (example [Chromatogram1] for the module 
A) 
[ModulePN{moduleIndicator}] : Write the module part number (example [ModulePN1] for the module A) 
[InjectorHeated{moduleIndicator}] : Write "True" if the injector is heated otherwise "False" (example 
[InjectorHeated1] for the module A) 
[InjectorTempMin{moduleIndicator}] : Write the minimal injector temperature (example 
[InjectorTempMin1] for the module A) 
[InjectorTempMax{moduleIndicator}] : Write the maximal injector temperature (example 
[InjectorTempMax1] for the module A) 
[ColumnType{moduleIndicator}] : Write the column type (example [ColumnType1] for the module A) 
[HasBackflush{moduleIndicator}] : Write "True" if the instrument has a backflush column otherwise "False" 
(example [HasBackflush1] for the module A) 
[ColumnTempMin{moduleIndicator}] : Write the minimal column temperature(example [ColumnTempMin1] 
for the module A) 
[ColumnTempMax{moduleIndicator}] : Write the maximal column temperature(example 
[ColumnTempMax1] for the module A) 
[CarrierGas{moduleIndicator}] : Write the carrier used for the specified module (example [CarrierGas1] for 
the module A) 
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[DetectorType{moduleIndicator}] : Write the detector type used for the specified module (example 
[DetectorType1] for the module A) 
[InjectorType{moduleIndicator}] : Write the injector type used for the specified module (example 
[InjectorType1] for the module A) 
[ChannelEnabled{moduleIndicator}] : Write if the module is used (example [ChannelEnabled1] for the 
module A) 
[InjectorTemp{moduleIndicator}] : Write the injector temperature used for the specified module (example 
[InjectorTemp1] for the module A) 
[ColumnTemp{moduleIndicator}] : Write the column temperature used for the specified module (example 
[CColumnTemp1] for the module A) 
[InjectTime{moduleIndicator}] : Write the injection time used for the specified module (example 
[InjectTime1] for the module A) 
[BackflushTime{moduleIndicator}] : Write the backflush time used for the specified module (example 
[BackflushTime1] for the module A) 
[AnalysisTime{moduleIndicator}] : Write the analysis time used for the specified module (example 
[AnalysisTime1] for the module A) 
[RampRate{moduleIndicator}] : Write the ramp rate used for the specified module  (example [RampRate1] 
for the module A) 
[Pressure{moduleIndicator}] : Write the pressure in PSI used for the specified module (example [Pressure1] 
for the module A) 
[TCD{moduleIndicator}] : Write if the detector is activated for the specified module (example [TCD1] for the 
module A) 
[Range{moduleIndicator}] : Write the signal range used for the specified module (example [Range1] for the 
module A) 
[Rate{moduleIndicator}] : Write the signal rate used for the specified module (example [Rate1] for the 
module A) 
[SampleTime{moduleIndicator}] : Write the sample time used for the specified module (example 
[SampleTime1] for the module A) 
[InletTemp{moduleIndicator}] : Write the inlet temperature used for the specified module (example 
[InletTemp1] for the module A) 
[ContinuousFlow{moduleIndicator}] : Write if the continuous flow is used for the specified module (example 
[ContinuousFlow1] for the module A) 

 

 

To generate a customized report, go to "Process > 5. Report" and click on the following icon . 
 
The path of the original template file and the final report must be filled. Click on the validation button to 
generate the report. 

 

 
 

Note : Possible extensions for the final file are docx, doc and pdf. 
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3.3 Calibration report 

Calibration is an important step in the validation of the analytical method and ensures that the results 
obtained are accurate and reliable. The calibration report is a document that summarizes this process. 
 
There are several ways to view this report: 

- From the results table:  

o Select an analysis   
o Right click on it   
o Select "Report > Calibration Report" 

 

 
 

- From the process section:  

o Select an analysis  
o Click on the "Calibration" menu 
o Select "Calibration Report"  

 

 

1 

2 

3 
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The chromatographic calibration report includes the following information: 

• The date of the calibration 

• The calibration method used 

• Chromatograph operating conditions (temperature, pressure, flow rate, etc.) 

• Raw data obtained during the calibration, including retention times and peak areas for each 
calibrated component 

• The calibration curves for each of the compounds present in the method. 
 
Here is an overview of a calibration report: 
 

 
 
Each of these parts can be visible or not, and their titles can be modified: for this, click on the button               to 
edit these parts. 
 

 
 
The button        is used to change the headers and footers. 
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3.4 Report of several analyses 

It may be useful to obtain a report on a series of analyses, to display their results and to overlay the 
chromatograms. This is possible by clicking on the button           from the "Results", "Reprocess" or 
"Calibration" tables: 
 

 
 
 

Here is an example of a report on an analysis series: 
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Each of these parts can be visible or not, and their titles can be modified: for this, click on the button               to 
edit these parts. 
 

 
 
 
The button        is used to change the headers and footers. 
 

3.5 Automatic printing after analysis 

The Analysis report and Customized report can be printed automatically after the analyses. 
To do this, you must log in as an Administrator (see chapter User identification), then select the "User" menu, 
click on "User settings" and click on "Print". 
 
Several automatic printing modes are possible: 

- Print the report after each analysis 
- Print the report after each analysis, for some methods (to be selected) 
- Print the report after each analysis, for some sequences (to be selected) 

 
Checking "Generate a report from a template file" will print the customized report. 
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4. Specific calculations 
The analysis method, as described above (see chapter Managing methods), is sufficient for all the ordinary 
calculations of chromatography. 
 
Soprane CDS offers the possibility to go much further than the simple concentration calculations and to carry 
out complementary calculations. Specific calculation options are available if they are enabled in the license. 
(ISO 6976, LPG, Combustion, Annex, Excel). 
 
The default values are those of perfect components at 1.01325 bars in compliance with ISO/DIS 6976:2016 
and experimental standard X20-522. 
 
The components detected and identified in the analysis are considered only if the name has a match in the 
reference tables.  
 

4.1 Calculation of the calorific value of natural gas (ISO 6976) 

Specific calculations reports according to ISO 6976:2016 can be generated at the end of the analysis. It is 
possible to create these reports with a series of calculations, a specific unit for ICV, SCV, and different 
temperature conditions. 
 

1 

2 

3 

4 
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In the Analysis tab, select the Options menu and click on Standard calculation. 
 
2 sub-menus are visible: 
 

1) Select calculation 
 
5 reports can be defined at the end of each analysis. 

 

To define "ISO 6976:2016" calculations, click "+" to add calculations (maximum 5) and "-" to reduce the 
number of reports. 
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For each calculation you can: 

• Activate the calculation (check "Used"). This action will create the report at the end of the analysis. If the 
"Used" box is unchecked, the calculation parameters will be considered, but the report will not be created 
at the end of the analysis. 

• Define temperature conditions. The ISO 6976 standard can be applied to specific temperature conditions. 
Select the desired temperature conditions. 

• Select the unit for the calculation of the ICV and SCV. 

• Select the calculations to be performed. 
 
Note: 
The Wobbe index and the compression factor will not be calculated if the selected unit is "Btu / scf", "MJ / 
mol", "kJ / mol". 
 

2) Coefficients table 
 
The ISO 6976:2016 reference coefficients table is stored in the file "iso6976-2016.coef" (in the Soprane CDS 
installation directory). To edit the values, select the "Coefficients table" sub-menu. 
 
The ISO 6976:2016 reference coefficient table can be found in the "Iso 6976:2016" tab section. 
 
The editor is under the form of a table containing the reference coefficients, a list containing the temperature 
and reference conditions specified in the ISO 6976 standard and a panel of commands. 
 

 
 
The table is composed of the columns "Component", "Molecular mass", "SCV" and "Summation factor". 
For each reference compound you will find its molar mass, reference SCV as a function of reference 
temperature conditions as well as the summation factor which also varies according to the reference 
conditions. 
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You can remove a component by clicking on         . To add a component, click on           . A new line will be 
added at the end of the table. To insert a component into the table at a specific position, click in a cell of the 
component which will take over the new component, then click on the "Insert" command. Enter the name 
and reference coefficients of this component and save the information by clicking on the "Save" button. 
 
The user can redefine his own reference values for each temperature and reference condition. These values 
will be stored in the current analyzer database. At any time, the user can restore the original values by clicking 
on the "Restore" button. 
 
If you change the temperature conditions (from 0°C / 0°C to 15°C / 0°C for example), the coefficients table 
will be updated according to this information. The SCV, and summation factors are different depending on 
the temperature conditions. 
 
To restore the original table, click on the "Restore" command in the Coefficients Table window. Soprane CDS 
will display the coefficient values of the file "iso6976.coef". 

 

Click on the "Restore" button to reset the analyzer's reference coefficients. 
 
You can add, modify, or delete these coefficients. Validate the modifications by clicking on the "Save" button. 
 
By checking "Nb atoms", a column entitled Carbon is added, indicating the number of carbon atoms in each 
compound. 

4.2 RGA calculation (EN 15984) 

The EN 15984 standard defines a gas chromatographic analysis method for the determination of the 
composition of refinery fuel gases. The results obtained are used to calculate their carbon content as well as 
their inferior calorific value 
 
In the Analysis tab, select the Options menu and click on Standard calculation. 
 

 
 
For these calculations, there are no reference coefficients. 
 

4.3 Methane number calculation 

The Gas Research Institute (GRI) methods are used to calculate methane number, and motor octane number; 
the linear relation is useful in determining and comparing the knock resistance of high methane content 
natural gas. 
 
In the Analysis tab, select the Options menu and click on Methane number. 
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- Hydrogen carbon ratio: Ratio between number of carbon and hydrogen atoms. 
- Methane number: measure of resistance of a gas fuel to knock, which is assigned to a test fuel based 

upon operation in knock testing unit at the same standard knock intensity. 
- Motor octane number: numerical rating of knock resistance obtained by comparison of its knock 

intensity with that of primary reference fuels. 

4.4 Combustion calculation 

Increased attention given to the quality of combustion emissions and high cost of energy impose a greater 
interest in the optimization of the combustion in boilers and burners in general. The relationship between 
air and fuel, combustion products, are critical parameters that need to be monitored and controlled. 
 
Soprane CDS carries out the combustion calculations and generates a report at the end of the analysis. In the 
Analysis tab, select the Options menu and click on Standard calculation. 
 
2 sub-menus are visible: 
 

1) Select calculation 
 
In the calculation selection window, click on the "Combustion" tab and then check the calculations to be 
carried out. 
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2) Coefficients table 
 

 
 
The table is composed of the columns "Component", "Molar mass", "Fact. of compression", "H2O", "CO2", 
"O2", "Coef. comb.", "Critical temp.", "Critical press.", "Coef. 2 degree", "Coef. 1 degree", "Constant". 
 

4.5 LPG calculation (ISO 8973) 

In case of LPG analyses, Soprane CDS can display an annexed report of results according to the ISO 8973 
standard.  The user selects the reference parameters as well as the calculations to be performed and the 
results will be generated at the end of each analysis. 
 
To set the report, in the Analysis tab, select the Options menu and click on Standard calculation, then click 
on Select calculation. 
 

1) Select calculation 
 
The " ISO 8973 :1999 - LPG" tab displays the ISO 8973 calculation options. Select the basic parameters 
(calculation unit, reference temperature and concentration unit) and select the calculations to be carried out. 
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The results will be displayed in a specific section of the final report that will be generated at each end of the 
analysis. 
 

2) Coefficients table 
 
The ISO 8973 reference coefficients table is stored in the "gpl.coef" file (in the Soprane CDS installation 
directory). To edit the values, select the "Coefficients table" sub-menu. 
 
The ISO 8973:1999 standard reference coefficients table can be found in the section of the "ISO 8973 - LPG" 
tab. 
 
The editor is presented under the form of a table containing the reference coefficients, a list containing the 
temperature and reference conditions indicated in the standard and a panel of commands. 
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The table is composed of the columns "Component", "Molar mass", "Nb carbon", "Sum C3" "Sum C4", "Sum 
C5", and "Coef. M Vol", "Abs. press. vapor @ 37.8, @ 40, @ 50  and @ 70°C", "Olefines" and "Index fact. 
Octane". 
 
You can remove a component by clicking on         . To add a component, click on           . A new line will be 
added at the end of the table. To insert a component into the table at a specific position, click in a cell of the 
component which will take over the new component, and then click on the "Insert" command. Enter the 
name and reference coefficients of this component and save the information by clicking on the "Save" button 
 
The user can redefine his own reference values for each temperature and reference condition. These values 
will be stored in the current analyzer database. At any time, the user can restore the original values by clicking 
on the "Restore" button. This action will empty the current table (specific to the analyzer) and insert the 
default values of the gpl.coef file. 
 
The user can also update this file from the current table. 
 

4.6 Additional calculations 

Other specific calculations can be applied to the analyses results. For this, in the Analysis tab, select the 
Options menu, click on Standard calculation, on Standard calculation then click on the Annexes calculation 
tab. Check the box that corresponds to the calculation you want to perform. If you do not wish to make any 
calculations, check the "None" box. 
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4.6.1 Gas purity calculation 

The gas purity is calculated with the standardized concentrations. The concentration of the referenced 
component (in this case helium) is calculated by sub-straying at 100 the sum of the standardized 
concentrations of all the other compounds of the analysis. If units are different from %, a calculation is 
applied to the standardized concentration to set it back to %. 
 

 
 

4.6.2 Helium calculation 

 
 

 

Helium estimation is related to ISO 6976 and natural gas analysis, it must be added to the ISO 6976 calculation 
option. 
Helium is naturally present in natural gas, but it is not measured by a conventional GC analyzer (because 
helium is used as the carrier gas). 

 

This option is used to calculate the helium concentration, estimating it from the measured CH4 concentration. 
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4.6.3 Concentration for unknown peaks 

 
 
When this option is checked, a concentration estimate is calculated for the unknown components with 
reference to the calibration of a species identified and calibrated in the analytical method.  
Specifically, if the unknown peaks are quantified based on the calibration of species X, then the quantification 
results for the unknown species will be obtained in equivalent to species X and in the same concentration as 
species X. 
 
This tool can be used in two different ways: 

• Soprane CDS can give a quantification result per unknown peak in X-equivalent. 

• Soprane CDS can also sum the areas of all the unknown peaks and give a global quantification result 
for all the unknown species, still in X equivalent. 

 

The field "Reference component" corresponds to the name of the compound to be followed: the 
concentrations of the unknowns will be calculated according to its equation. 
 
By adding a "Component name", a new peak will be added to the results with the indicated name. The 
concentration, area, height values will be equal to the sum of the unknown compounds in the module 
containing the reference component. The normalized concentrations will be updated. 
 

 
 

If no value is added to the "Component Name" field, the concentrations, and normalized concentrations of 
the unknowns in the reference compound module will be updated. 
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4.6.4 Retention time delta 

 

 
 
When this option is checked, the retention time delta is calculated between the expected retention time and 
the retention time. 

4.7 Excel calculations 

An option of Soprane CDS enables to link with an EXCEL file to define any kind of calculations. 
A number of things are imposed, so that Soprane CDS knows where to write and where to read the data. 
 
If the option is enabled, click on the "Options > Excel" menu, the following screen will appear: 
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The fields to fill in are: 

- Template : full path of the Excel file template 
- Result file : full path of the final Excel file 
- Sheet name : Corresponds to the name of the Excel sheet in which Soprane CDS will write and read 

the data. 
- Peak cell name 
- Results cell name 
- Analog input cell name 
- Sample information 

 
Guide points are necessary and are located in column A; they correspond to the names of the cells (in the 
example below: "Coumpounds", "Calculations"...) 
 
At runtime, Soprane CDS searches in column A the cell of the compounds. The following rows must 
correspond to the names of the constituents, as they are known by Soprane CDS (programming of the 
identification table). This enables Soprane CDS to identify each constituent. When a constituent is found, its 
raw concentration is written on the same line, in column B, then its normalized concentration, always on the 
same line in column C and so on for the other values. 
 
Soprane CDS then searches in column A for a cell corresponding to the calculations (in the example below: 
"Calculations"). 
 
The results calculated by the EXCEL sheet must be found in the following lines, according to the following 
format: 
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• Column A: name of the result 
• Column B: description 
• Column C: numerical value 
• Column D: units 
• Column E: number of decimals of the result. 
 
The same process is repeated for the analog inputs and the sample information. 
 
The rest of the sheet is available for the user who can store constants or calculation formulas. 
 

 
 
 

5. Managing files 
Soprane CDS uses several files to store the analyzer configuration, the different analysis methods, the 
integration methods, the results, ... 
These files are, for the most part, linked to each another and moving one of these files from one directory to 
another can have unfortunate consequences. 
 
To export and import data, the best way is to use the specially designed File Manager            utility. 
It gives the user the ability to copy, delete, move files, export, or import them. 
 
The File Manager tool is in the Soprane CDS installation directory. 
 

5.1 Export data 

It may be useful to send some data such as analyses, methods; that's why the File Manager            tool is very 
useful. 
 
When loading, the main screen is displayed: 
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By default, the export mode is activated, the first data table contains all the analyses corresponding to the 
selected analyzer and series. 
 
These analyses can be added by selecting them and by clicking on the button      .  Once added, the analyses 
will be displayed in the second table below containing all the analyses that will have to be exported. To 
remove one or several analyses, just click on the button          . 

 

Log files can be added to the export by clicking on the button            . 

 

To compress the data, click the Export button. Then select the location of the data. 

 

Note:  
To facilitate the search of analyses to be exported, the two tables in this view can be filtered and sorted. 
 

5.2 Import data 

The import is used to create a new analyzer with all the corresponding analyses and methods. To do this, all 
you have to do is locate and open the file with the .szip extension by clicking on the load button           .             
 
IMPORTANT NOTE: 
When importing, Soprane CDS copies the configuration file and therefore deletes the one that was used. This 
has no consequence when exchanging with SRA Instruments since the imported configuration file (if SRA 
Instruments returns you corrected files) is a copy of your own configuration file. 
If you export data to a computer that is working with another analyzer, its configuration file will be destroyed. 
 
The following display is then displayed: 
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All the analyses of the loaded file are then listed in the table of the previous display. These are the analyses 
to be imported. 

 

The next window proposes to edit the names of the analyzers and the locations of the result files; to do this, 
click on the button          .  
 
Once validated, the information in the table will be updated. 
 
The import will be done by clicking on Import. Once the import is successful, a new analyzer will be created 
as well as its shortcut on the desktop. 

5.3 Importing Soprane 1 analyses 

5.3.1 Exporting Soprane 1 files 

The first step consists in exporting the Soprane 1 analyses in the "axy" format. 
 
To do this, open Soprane 1, then click on "Process" 
 
Then click on the "Options" menu, "Import / Export (point file)" and "Export analysis files (ASCII)". 
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Check " Abscissa and ordinate of the points " and click on " OK " to export in the " Chrom " folder of Soprane 
(by default C:\Soprane\Chrom) 
 

 
 

 

5.3.2 Importing analyses into Soprane CDS 

The 2nd step consists in importing the "axy" files into the Soprane CDS software. 
 
To do so, open the "File Manager" application of Soprane CDS. 
 
Select the "Soprane 1" menu and then "Update Soprane 1’s analyses". 
 

 
 
 
Select the instrument for which to import Soprane 1 analyses, then select the method for each analysis. 
 
Click on "Import" to add them in Soprane CDS. 
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6. Modbus 
A specific software, named SRA.Soprane.Modbus, is used to exchange data between the Soprane CDS 
software and another computer via the Modbus industrial network. 
 
Thus, the results of an analysis can be fully transmitted: date, time, stream, measurement or calibration, 
concentrations, calculation results. 
 
The data that can be exchanged are stored in an address table. The transmission protocol complies with a 
standard which consists in requesting or transmitting a question and in response the value of the variable 
located at a given address is transmitted. 
It is therefore necessary to define an exchange table specifying the variables to be read, their address and 
their format.  
 
Next, it is required to define the hardware configuration and to determine the writing address of each of the 
information. 
 
The standard Modbus link can dialogue via an Ethernet port, an RS232 serial COM port (if the cable is less 
than 10 meters) or RS485. In the case of a RS232 or RS485 serial link, refer to the documentation of the card 
used. The communication protocol must be in agreement with the supervisor. 
 

6.1 Communication configuration 

The configuration program of Soprane CDS               enables to define the configuration of this serial link. 
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The Modbus configuration window is only displayed if the installation includes a Modbus option. 
 
Click on          , then select the MODBUS tab.     
 

 
 
In this window:  

• Choose the type of bus, that is the communication protocol to communicate with the remote system.  
o If you choose Modbus to serial port, select the serial port used. In this case, the "Parameters" 

button is used to view and modify the transmission parameters (speed, number of bits, 
parity, number of stop bits, control type).  

o If you choose Modbus to TCP/IP, keep the 502 value for the port number.  

• Indicate a slave number for Soprane CDS. 

• Select a transmission mode. 
 
Validate with the Ok button and exit Soprane CDS Configuration by validating the saving of the modifications. 
 
Note : 
The SRA.Soprane.Modbus software is automatically launched after Windows initialization. 
Consequently, the modification of the parameters will only be effective when Windows is restarted. 

6.2 Standard Modbus configuration 

Note : Before considering the configuration, it is better to perform some analyses with Soprane CDS, create 
the table of peaks, and select the calculations if there are any. Thus, at each end of analysis, the MODBUS 
software will retrieve the names of all these data and the configuration of the addresses will be facilitated. 
 
The MODBUS software is used to assign an address and a scale factor for each variable. 
This software is running as a background task and, under normal functioning, its window is not shown. 
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If the MODBUS software is running correctly, the SRA Instruments icon must be present in the notification 
area. 

 
 
Double-click on the icon and click on Open. The following window is opened: 

 

 
 
The data are separated into several sections: 

• The system variables of the analyzer: "Instrument" 

• The system variables of the analysis: "Samples / Calibrations" 

o The values in relation with the components: "Results" 

o The values in relation with the calculation: "Specific calculation" 

o The values in relation with the alarms: "Alarms" 

• The values in relation with the analyzer status: "Status" 

• The values in relation with the analog inputs: "Analog inputs" 

• The values in relation with the Excel file: "Excel" 

• The values in relation with the components codes: "Index" 

• The values in relation with the alarm editing values: "Alarm edition" 

• Boolean values: "Custom". 

 
For each transferred data, an address and a value type are assigned, and for the results, a coefficient 
submitted as an integer (short or real). 
 
This setting is performed directly in the MODBUS software via the "Addresses" tab. 
 
In a first time, it is better to test whether the communication is correct (see Communication test). 
 
The "Raw data" tab contains all Modbus values in four different tables. Two tables store on/off discrete 
values (coils) and two store numerical values (registers). The coils and registers each have a read-only table 
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and read-write table. Each table has 9999 values. Each coil or contact is 1 bit and assigned a data address 
between 0000 and 270E. Each register is 1 word = 16 bits = 2 bytes and has data address between 0000 and 
270E. 
 

6.2.1 Instrument variables 

The variables that can be used are: 

• Selected stream: In the case of a multi-stream application, this value indicates the current selected 
stream. 

• Analyzed stream: In the case of a multi-stream application, this value indicates the number of the 
analyzed stream corresponding to the displayed results. 

• Next sampling stream: In the case of a multi-stream application, this value indicates the number of 
the stream to be analyzed next. 

• Change stream : In the case of a multi-stream application, this value is used to change the number 
of the selected stream. 

• Inject top: This value is set at 1 each time an analysis is started. 

• Analysis type: This value indicates the type of analysis performed (0 = blank, 1 = sample, 2 = 
standard). 

• Alarm: This value indicates the different alarms obtained during the analysis in the Soprane CDS 
software. It can take several values; these values are obtained according to a combination of bits. 

- 0: no alarm 
- 1: chromatograph default 
- 2: cycle stopped 
- 4: invalid or unknown method 
- 8: defective connection with the chromatograph 
- 16: unable to process results  
- 32: default sample flow rate (option) 
- 64: default with flow selector or multi-position valve (option) 
- 128: Component default 

Example:  
- If chromatograph fault + Component fault = 129 
- If cycle stopped + carrier gas fault = 34 

• Life bit: this variable is used to monitor the transmission. Its value is updated every second. 

• Analysis time: This variable is used to know the analysis time 

• Current analysis time: This variable is used to know the elapsed analysis time 

• Sampling time: This variable is used to know the sampling time 

• Current sampling time: This variable is used to know the elapsed sampling time 

• Cycle time: This variable is used to know the cycle time (interval between injections) 

• Current cycle time: This variable is used to know the elapsed cycle time 

• Analysis index: This variable is used to know the number of analyses performed 

• Method: This variable is used to know the loaded method (the number corresponds to the position 
of the method in the list of methods sorted in alphabetical order) 

• Change method: This variable is used to change the method (the number corresponds to the position 
of the method in the list of methods sorted in alphabetical order) 

• Calibration validity: This variable is set to 1 when the validity of the calibration has expired 

• None: Register without effect 

• Instrument number: Indicates the serial number of the instrument 

• The current year 

• The current month 

• The current day 

• The current hour 

• The current minutes 
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• The current seconds 

• Status: This variable is used to monitor the Soprane CDS cycle. It can take the following values: 
- 0: Wait 
- 1: Chromatograph ready 
- 2: Waiting for start 
- 3: Waiting for injection (sampling) 
- 4: Analysis in progress 
- 5: Recovering points 
- 6: Analysis completed 
- 7: Bake out 
- 8: Error processing 

• Module status: Breakdown of module elements. 
Each module is made up of different elements: 
Heated inlet, Heated injector, Heated column, Carrier gas, Detector. 
Each element can have different states: Off => 0 (in binary 0), Not Ready => 1 (in binary 1), Ready => 
2 (in binary 10). 
 

Example: If the detector is Off, the pressure is good, the column temperature is heating, the injector is off 
and the heated inlet is ready, we'll have 
 
Input 2 => 10 
Injector 0 => 00 
Column 1 => 01 
Carrier gas 2 => 10 
Detector 0 => 00 
i.e. 0010010010 which in decimal gives 146 
 
If the register is not 682 in decimal (001010101010 in binary), the module is not ready. 
 

• GC Ready: This variable indicates the state of the chromatograph. It can take the following values: 

- 0: Not ready 

- 1: Ready 

- 2: Default 

• Restart: this command, set to 1, will initiate a MicroGC restart. 

• Restart command acknowledgement: this variable is set to 1 when a Modbus restart request has 
been acknowledged (it is reset to 0 ten seconds later). An additional checkbox allows you to restart 
the computer. 

• Command acknowledgement: this variable is set to 1 when a Modbus analysis request has been 
accepted (it is reset to 0 ten seconds later) 

• Start: This variable is used to launch analyses via Soprane CDS. It can take several values: 
- 0: No analysis requested, or cycle stopped after the current analysis. 
- 1: Start of analyses in simple analysis mode. 
- 2: Start a single sequence. 
- 3: Start of analyses in automatic mode. 
- 4: Start of analyses in calibration mode. 

• Nb of analyses / Sequence No.: This variable is used to indicate the number of analyses requested 
in the case of analysis request type 1. For the other types, it indicates the number of the sequence 
to be performed. This assignment is done in the Soprane CDS configuration software via the "Modbus 
/ Analysis sequence" menu: 
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Note that if this variable has a value of zero, either the analyses are not launched or the analyses are 
stopped at the end of the current analysis. 

 
To add these variables: 

- Select the analyzer 
- Click on the add button of the Instrument parameter 
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- In the window that appears, select the variable, type the address number. 
 

 
 

6.2.2 Sample/Standard variables 

The variables that can be used are: 

• The year of the analysis 

• The month of the analysis 

• The day of the analysis 

• The hour of the analysis 

• The minutes of the analysis 

• The seconds of the analysis 

• The data ready flag: Modbus uses this variable and passes it to 1 to indicate that the results of the 
analysis are available. It is up to the remote computer to reset it to 0 when it has read these values. 

• The compounds alarm: the value of this variable is decomposed into 16 bits. If a Soprane CDS alarm 
is triggered, the bit corresponding to this alarm will be active. 

• Total concentration: Displays the sum of the concentrations of the analysis 

• Total normalized concentration: Displays the sum of the normalized concentrations of the analysis   

• Total area: Displays the sum of the areas of the analysis   

• Total area of unknown peaks: Displays the sum of the areas of the unknown peaks of the analysis   

• Nb Peaks : Displays the number of peaks detected in the analysis 

• Nb Unknown peaks : Displays the number of unknown peaks detected in the analysis 
 

To add these variables the principle is the same as previously:  

- Select the analyzer 
- Select "Sample" or "Calibration" by clicking on it 
- In the menu bar, select "Addresses / Add" 
- In the window that appears, select the name of the variable, type the address number. 

 

6.2.3 Results variables 

MODBUS offers the possibility to choose from a range of values: 

• Area 

• Raw concentration 

• Normalized concentration 

• Retention time 

• Height 

• Delta retention time 

• Update Retention time 

 

To add these variables the principle is the same as previously:  

- Select the analyzer 
- In the menu bar, select "Addresses" 
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- In the Results section, click on Add. 
- In the window that appears, select the name of the variable, type the address number, and select 

the type (short integer, long integer, real)  

 

 
 

The coefficient is used to transfer the decimals of the value. Indeed, the values transmitted with this choice 
of 'type' are always integer values and therefore the decimals are deleted. For example, if you want to have 
two digits after the decimal point, the trick is to set the coefficient to 100. The value will then be multiplied 
by 100 before being sent and it will be enough to divide the received value by 100 to obtain a value with two 
decimals. Caution, the maximum value sent cannot exceed 65535 with the 'short integer' type so it is 
necessary to configure this coefficient correctly according to the unit of the component. This maximum value 
can be modified with the 'Full scale' value in the "Configuration"  menu (hammer icon at the top right of the 
window) (see paragraph Modbus options). 

 

6.2.4 Specific calculation variables 

Soprane CDS can perform post-analytical calculations. These calculations are, for example, the molar mass, 
the density, the calorific capacities, ... Several sets of calculations can be used, the calculations can be the 
same but performed under different temperature or pressure conditions. 
If the value corresponds to a calculation made in Soprane CDS, it is necessary to select the value Calculation 
1 or Calculation 2. 
 
To add these variables the principle is the same as previously:  

- Select the analyzer 
- In the menu bar, select "Addresses" 
- In the Specific calculation section, click on Add. 
- In the window that appears, select the name of the variable, type the address number, and select 

the type (short integer, long integer, real) and the coefficient. 
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6.2.5 Analog input variables 

To add these variables the principle is the same as previously:  

- Select the analyzer 
- In the menu bar, select "Addresses" 
- In the Analog input section, click on Add. 
- In the window that appears, select the name of the analog input, the address number, and the 

coefficient. 

 

6.2.6 Analyzer status variables 

To add these variables the principle is the same as previously:  

- Select the analyzer 
- In the menu bar, select "Addresses" 
- In the Status section, click on Add. 
- In the window that appears, select the value to be monitored, the address number and the module 

index (e.g. Module A = 0, Module B = 1...). 
 
The variables that can be used are: 

- The pressure of a module 
- The temperature of a column 
- The temperature of an injector 
- The temperature of an inlet 
- If the module is ready 

 

6.2.7 Excel variables 

To add these variables the principle is the same as previously:  

- Select the analyzer 
- In the menu bar, select "Addresses" 
- In the Excel section, click on Add. 
- In the window that appears, select the value to be monitored, the address number and the 

coefficient. 
 

6.2.8 Component code variables 

To add these variables the principle is the same as previously:  

- Select the analyzer 
- In the menu bar, select "Addresses" 
- In the Index section, click on Add. 
- In the window that appears, select the value to be monitored, the address number and the 

compound index. 
 

6.2.9 Editing alarms variables 

To add these variables the principle is the same as previously:  

- Select the analyzer 
- In the menu bar, select "Addresses" 
- In the Alarm modification section, click on Add. 
- In the window that appears, select the alarm, the address number and whether to modify the 

minimum or maximum value. 
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6.2.10 "Custom" variables 

To add these variables the principle is the same as previously:  

- Select the analyzer 
- In the menu bar, select "Addresses" 
- In the Custom section, click on Add. 
- In the window that appears, select the address number and define the value to be followed for each 

bit. 
 

The variables that can be used are: 

• Analyzer status: sets register to 1 if analyzer status matches selected status 

• Module status: It is possible to monitor the status of several elements (see below), the register will 
be set to 1 when the status of the selected element is ready. 

o Ready: Monitors the status (ready or not) of the selected module. 
o Inlet heating: Monitors the status (ready or not) of the selected module's inlet. 
o Injector heating: Monitors the status (ready or not) of the selected module's injector. 
o Pressure: monitors the status (ready or not) of the selected module's pressure 
o Column temperature: Monitors the status (ready or not) of the selected module's column. 

• Alarm fault: 
o Alarm fault: Sets bit to 1 when an alarm is triggered 
o Non-metrology alarm fault: Sets bit to 1 when a non-metrology alarm is triggered. 
o Metrology alarm fault: Sets bit to 1 when a metrology alarm is triggered. 

• Specific alarm: Sets the bit to 1 if the selected alarm is in fault. 

• Command: This bit is in read/write mode, and is used to launch commands 
o Stop analysis: When the bit is set to 1, a request is made to stop the analysis. 
o Start sequence: When the bit is set to 1, a request is made to start the selected sequence. 
o Restart: When the bit is set to 1, a request is made to restart the instrument. 
o Sequence in progress? : When the bit is set to 1, it indicates that the selected sequence is 

under analysis, otherwise it is set to 0. 
o Acknowledgement of stop command: this variable is set to 1 when a request to stop analysis 

via Modbus has been acknowledged (it is reset to 0 ten seconds later).  
o Acknowledgement of sequence start command: this variable is set to 1 when a request to 

start the selected sequence via Modbus has been acknowledged (it is reset to 0 ten seconds 
later). 

o Acknowledgement of restart command: this variable is set to 1 when a restart request via 
Modbus has been acknowledged (it is reset to 0 ten seconds later). An additional checkbox 
allows you to restart the computer. 
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6.2.11 Modbus options 

To access the Modbus options, click on the hammer at the top right of the Modbus window. 

The following window appears: 
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• Delay to reset data flag: at the end of the analysis, the data flag changes to 1. After the set delay, 
the flag returns to 0. If the delay is 0, this option is not enabled. 

• Number of decimals: enables you to set the number of decimal places to be displayed for the display 
of all the values in the main window of the software. 

• Full scale: In RTU mode, and if the format of the values is 16-bit integer it is necessary to specify a 
full-scale value that is used to convert the data to 0-10000 or 0-65535 scale. In this mode, the value 
representing the constituent, or the calculation is transmitted after being converted to a number in 
the range 0-10000 or 0-65535. 
Let us assume a component with a concentration of 5. The programmed scale value is assumed to 
be 20. Here we select a scale of 10000, which means that 20 becomes 10000. The value transmitted 
to the host computer will be 2500. 

• Delay to refresh before alarm: If the values are not refreshed after this time, SRAMODBUS will raise 
an alarm for no refresh. 

• Swap Floating Point bytes: if the option is checked, the low weight and the high weight of the values 
transmitted in the real format are inverted. 

• Ignore command if same value: if the option is checked, a Modbus master sends a command (e.g. 
start analysis) and the register already has the same value, Soprane CDS will not receive the 
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command as it has already been taken into account. 

• Send "Invalid address" error on unconfigured addresses : if the option is checked, and a Modbus 
master asks to read a register that is not configured in Soprane CDS, then Soprane CDS will send an 
"Invalid address" Modbus error. 

 

6.2.12 Viewing the results 

To view the values sent by the Modbus link, it is necessary to click on the "Addresses" tab, the values of the 
registers are displayed in the right part of the window. 
 

 
 

6.3 Configuration of the standard Modbus port 

Hardware configuration  

Serial port Usable port : MODBUS 

Port RS485 2-wire or 4-wire 

Slave 1 to 255 

Transmission mode  RTU, ASCII 16 bit, ASCII 32 bit 

Protocol Modbus (default) / Jbus 

Transmission speed 1200, 2400, 4800, 9600, 19200 

Data  8 bits or configurable by windows 

Parity Without or configurable by windows 

Stop bit 1 or configurable by windows 

Control signals Without or configurable by windows 

 

6.4 Communication test 

In a first time, it is better to test if the communication is correct.  
 
Configure the life bit parameter at address 1: Select the analyzer, then click on the add button. 
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Select the following parameters and confirm with the validation button. 

 

 
 
From the main Modbus screen, click on "Save". 

 

From your supervisor: 

- Check that the configuration corresponds to the configuration defined in Soprane CDS : 
communication medium, IP address if TCP/IP mode or communication protocol (speed, parity) and 
slave number if serial link. 

- Program a Modbus reading of 3 first addresses in integer (addresses 1, 2 and 3). Indeed, in some 
cases, there may be an offset of an address and therefore by defining a reading frame as well, this 
will enable you to check if the address numbers match. It is better to provide a rather long refreshing 
time (> 100 ms or even every second) because the values evolve only after each analysis and so this 
function does not use too many resources on the PC. 

 

If the reading is correct, then the configuration of the addresses can be envisaged. 
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7. Access rights 
There are several identification levels: Operator, Support, Auditor and Administrator. 
  
By default when Soprane CDS is launched, the level is in "Not connected". 
 
To access the user management, the icon         is available at the top left of the title bar. 
 

 

7.1 User identification 

To identify yourself, use the icon   

Two information are required: 

• The user name 

• The password 

 
Once these two information are valid, the user will be selected. 
 
(For the following chapters, the user must be authenticated as an administrator.) 

7.2 Creating a user 

Adding a user is only possible if an Administrator is already logged in (see previous paragraph). 
 
Once the administrator is logged in, click on          and the following menu appears: 
 

 
 

Click on "New User", the following screen appears: 
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The fields to be filled in are:  

• The user profile 

• The name of the user 

• The password 

7.3 Deleting a user 

Deleting a user is only possible if an Administrator is already logged in (see paragraph User identification). 
 
Once the administrator is logged in, click on          and the following menu appears: 

 

 
 

Click on "Delete User", the following screen appears: 
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The fields to be filled in are:  

• The user profile 

• The name of the user 

7.4 Changing the password 

Changing a user’s password is only possible if a User is already logged in (see paragraph User identification). 
 
Click on         then click on "Modify password". A new window will open proposing to fill in the fields 
concerning the new user: 

 

• The current password 

• The new password  

• Confirmation of the new password 

 
 

 
 

7.5 Managing a user 

User access management is only allowed for an Administrator (see paragraph User identification). 

Once the administrator is logged in, go to the User tab  and click on the user profile "Not connected", 
"Operator", "Support", "Auditor" or "Administrator". 

 

 
Each check mark represents an action of Soprane CDS. If it is checked, the user will have the right to perform 

the action otherwise it will be locked.  
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To manage the complexity of passwords, an "Administrator" can do so by selecting the "User" menu and 

clicking on "User Settings" then "Password". 

 

 

  

1 

2 

3 
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8. Appendix I: Chart 
The graph is a very useful element to display a signal, it also offers a wide range of features such as zooming 
on a signal or in the axis, moving on the graph ... 
 
For help on how to navigate on a chromatogram, click on the button         which displays the series of icons 
below then click on 
 

 

8.1 Zoom in / Zoom out 

- Scroll the mouse wheel on the graph to zoom in / zoom out 
- Select an area of the chart 
- Scroll the mouse wheel on the horizontal axis to zoom in / zoom out horizontally 
- Scroll the mouse wheel on the vertical axis to zoom in / zoom out vertically 
- Double right click on the horizontal or vertical axis to zoom 
- Double left click on the horizontal or vertical axis to zoom out 

8.2 Navigation 

- Drag the mouse over the horizontal or vertical axis to move on the graph 
- Ctrl + Drag the mouse to move on the graph 

8.3 Palette 
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8.4 Shortcuts 

- F11: Screenshot of the graphic in the clipboard 
- Ctrl + S: Saves the graphic in image format 

8.5 Setting the elements to be displayed 

Several integration or display indicators can be added to the chromatogram. To do this, click on the button 
         then on  
 

 
 
 

Here are the elements available: 
 

 
 

8.6 Exporting 

Several types of export are available: 
- In CSV format 
- In the clipboard 
- In an image format 
- In a printable format 

 
To export a chromatogram, click on the button          ; the series of icons below is displayed: 
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CSV export Copy to clipboard 

Save as image 
Print 
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9. Appendix II: Integration process principles 
The integration of a chromatogram is done in the Process module, accessible via the "Process" tab  
 
 
 

9.1 Integration 

It is important to well understand how the integrator works and what effects may be caused by using the 
wrong parameters or integration events. 
 
During the analysis, the signal is sampled at a frequency sufficient to ensure a correct measurement. The 
frequency (20, 50 or 100 Hz) at which this sampling is performed is indicated in the analysis method. All 
values are stored for real-time display, for integration and for possible further processing 

 

The integration is performed in several steps: 

• First, the signal is examined to detect all points where "something" occurs. It is the beginning of a peak, 
it is the top, it is the end. At this point, a table is memorized with all the data concerning the detected 
peaks. 

• Then these detected peaks are inspected in detail depending on what the user wants to do. Should the 
beginning or the end of a peak be considered as the baseline or as a valley? Should the peak be grouped 
with the one before it or the one after it? Where is it relevant to place the baseline? Should the peak be 
rejected? ... 

• Finally, all calculations to determine the area, height, start time, start value, retention time, ... are 
performed and the results are stored in a table of integrated peaks. 

 
Another process is then activated to identify the peaks and to calculate concentrations or response factors. 

 

The peaks detection is the most important part of the integration process. If you don't detect the peaks, it is 
useless to try to correct their area. If you detect peaks where there is only background noise the problem is 
similar: you won't be able to ensure that the concentration value obtained is due to a compound. 
Thus, during the peaks detection it is necessary to use correct detection parameters. 
 

9.1.1 Events affecting the integration 

Peak detection 

Because it is not necessary to integrate all the peaks from the beginning of the injection to the end of the 
analysis and because unwanted peaks can be the consequence of a valve switching, for example, an event 
can be used to deactivate the integration. By default, integration is active. 
Note that the software considers to be at the baseline when integration becomes allowed or when it becomes 
forbidden, and a part of the peak that would be before or after would simply be ignored. 
 
Negative peak detection 
Sometimes a peak is negative, and in this case the working logic must be reversed. The Negative Peak 
Detection event fulfills this role. By default, the event is disabled, and the software expects positive peaks. 
Be careful, this event is complementary to the event allowing integration. To avoid unwanted interpretations, 
if the signal is not in the "baseline" state when reversing the working logic, it is often preferable to prohibit 
the integration (which forces recognition of the Baseline), to reverse the logic, and then to re-enable the 
integration. 
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Slope at the beginning of peak 
This event corresponds to the slope at the beginning of the peak expressed in µV/s and is used to set the 
detection threshold for significant elements. 
By default, the software uses a value of 0.001 µV/S. 
 
Slope at the end of peak 
This event corresponds to the slope at the end of the peak expressed in µV/s and is used to set the detection 
threshold for significant elements. 
By default, the software uses a value of 0 µV/S. 
 
Slope of apex detection 
This event corresponds to the slope at the apex of the peak expressed in µV/s and is used to set the detection 
threshold for significant elements. 
By default, the software uses a value of 0.001 µV/S. 
 

9.1.2 Baseline correction 

Baseline detection 

This event has 2 states ON and OFF. 
This event is used to correct a return to baseline too early or too late, which results in a baseline increase. 
The event is ON by default, which means that the integrator looks for, and can find, a return to baseline at 
the end of a peak or a group of peaks. 
 
Forcing baseline to all valleys 

This forcing is used to impose, over the time window in which it is active, that all valleys are treated as 
baseline crossings. 
The event is inactive by default. 
 
Tangential baseline 

Separates the small peaks from the major peak, the major peak is integrated from the beginning of the 
"group" of peaks to the end. 
 
Peaks grouping 

This event defines a time window where all peaks, isolated or not, will be grouped into a single peak for the 
calculation of response coefficients or the calculation of the concentration. 
The area of the peak group will be equal to the sum of the individual areas. The height of the peak group will 
be equal to the sum of the individual heights. The retention time of the peak group will be equal to the half 
sum of the window start time plus the window end time or end of analysis.  
These values will be arbitrarily assigned to the peak nearest to the retention time thus determined. To ensure 
identification, it will be sufficient to take the middle time and a window covering the whole area. A peak 
detected at the beginning, in the middle or at the end of the window will thus be recognized. 
L'événement est inactif par défaut. 
 

9.1.3 Rejection events 

Despite all precautions, peaks may be detected where there is only background noise or interference. It may 
be worth ignoring peaks that do not meet one of the following criteria. 
 
Minimum area for rejection 

A peak is rejected if its area is smaller than the value that this event has at the time found as retention time. 
The default value is 0. 
 
Maximum area for rejection 

A peak is rejected if its area is greater than the value that this event has at the time found as retention time. 
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The default value is 10 powers 100. 
 
Minimum height for rejection 

A peak is rejected if its height is less than the value that this event has at the time found as retention time. 
The default value is 0. 
 
Maximum height for rejection 

A peak is rejected if its height is greater than the value that this event has at the time found as retention 
time. 
The default value is 10 powers 100. 
 
Minimum concentration for rejection 

A peak is rejected if its concentration is lower than the value that this event has at the time found as retention 
time. 
The default value is 0. 

9.2 Identification 

Identification is the process by which a peak corresponds to a constituent. 
Identification is based on the retention time and an identification window. 
The identification window is defined with a time interval situated on either side of the retention time and 
consisting of a constant part (fixed window) and a part proportional to the retention time (variable window 
or % window). 
 
Assume an expected peak at the retention time of 50 seconds with a fixed window of 2 seconds and a variable 
window of 10 %. 
The time interval will be equal to 2 seconds plus 10 % of 50 seconds thus a total of 7 seconds and any peak 
whose actual retention time is between 43 seconds and 57 seconds could be identified as the expected peak. 
 
The problem of identification is the choice of the peak when several possible candidates are inside the 
identification window. 
The software allows a maximum of 10 peaks inside an identification window. 
It also considers the order in which the peaks are expected. Assume an already identified peak A and the 
searching of a peak B in a window containing several peaks including peak A. If the expected retention time 
of peak B is lower (higher) than the one of peak A, the searching inside the window will be limited to peaks 
whose real retention time is lower (higher) than the one of peak A. 
 

9.2.1 Reference peaks 

Identification can be more hampered because retention times fluctuate, forcing users to choose wider 
identification windows. 
This is true, but often the retention times fluctuate in the same way for all the peaks and the analysis includes 
one or more peak(s) easy to identify because they are properly isolated. 
This is also true in the case of columns requiring regular regeneration. In this case, the identification windows 
are enlarged to compensate the gradual drift of the values. 
It is convenient to use a wide window to identify an isolated peak (we can also force the identification of this 
peak, as we will see later), to define this peak as a reference peak (it is assigned a letter from A to Z to 
represent it), then to say that some other peaks use this reference peak (remember the identifier A to Z). In 
this case, the software considers that the retention times shift in the same way and the referenced peak will 
be searched in a window centered on a time equal to the expected retention time for this peak, divided by 
the expected retention time for the reference peak and multiplied by the retention time found for the 
reference peak. This allows to use narrower searching windows thus, to reduce the number of peaks likely 
to be in a searching window. 
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In case several references are used, the identification process assumes that the same peak could not be found 
in the searching window of several reference peaks (reference peaks sufficiently distinct from each other) 
and the attribution of peaks is done in the processing order without handling this type of error. 
The identification program indicates an error in case of looping leading to an impossibility of processing, of 
type peak x serves as reference for the peak y which serves as reference for the peak x. The error is reported 
but it does not lead to blockage and the peaks concerned are identified as normal peaks. 
If a peak is defined as a reference but is not used as such, it will simply be identified as a priority according 
to the peaks reference identification process, without leading to an error. 
Similarly, if a peak uses an undefined reference, the reference will be ignored without the error being 
reported. 
 

9.2.2 Forcing 

When several peaks are present in a search window, the software calculates a score taking into account the 
importance of the peak (majority peak) and its position in the window (peak closest to the center) then it 
takes the peak whose sum of the 2 scores is the highest. 

 

Identification forcing consists of ignoring one of the two processes. 
The field of the constituents table used to define the forcing is set at the value 0 in the absence of forcing 
(default value), the value 1 to force the largest peak or 2 if we want to force the peak the closest to the 
center. 
 

1) The most important peak 
 
When the peaks are sufficiently separated, one can hope to have only one peak per window and consider 
that the other peaks are only traces or noise. It seems logical to say that the main peak is the product to be 
identified. 
This can lead to errors when working with peak height. An interfering peak may have a significant height, 
taller than that of the analyzed product, while having a very low surface area. 
If the peaks are insufficiently isolated and the retention times tend to fluctuate, the identification windows 
of two neighboring components may overlap and a single window may have peaks similar in heights or 
surfaces. 

 

The field of the constituents table used to define the forcing has the value 1 if one wants to force the most 
important peak. 
 

2) The peak closest to the center 
 
This other way of proceeding consists in considering that the retention time of the constituents is precisely 
known and that the peak the closest to the center of the window (and therefore to the time at which it is 
expected) is the best candidate. 
This seems logical but does not consider that the retention time of a product is modified by the constituent 
concentration having a close retention time: a high concentration product tends to repel a lower 
concentration product. 

 

The field of the constituents table used to define the forcing has the value 2 if one wants to force the peak 
the closest to the center. 
 

9.2.3 General case 

Synthesizing these two conceptions means that they both exist and that it is better to use them both. 
When several peaks are present in a window, we determine for each of them a score function of their size 
and a score function of their deviation from the center of the window then the sum of these two scores is 
used to choose the peak to identify. 
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The size-related score is obtained by looking for the main peak and by dividing the height or area of each 
peak by the height or area of the major peak. The scores obtained are therefore between 0 and 1. 

 

The score linked to the position relative to the center of the window is obtained by dividing the shortest 
distance between the middle of the window and a top by the actual distance between the middle of the 
window and the top of each peak. Here again, a score between 0 and 1 is obtained. 
The peak with the highest sum will be the major peak located near the center of the window. 
 

9.2.4 Optimizing the process 

Identifications of reference peaks and forcing peaks occur by increasing times. 

 

The identification program starts by identifying the reference peaks, managing a possible reference level 
(reference peak that uses a reference peak, which uses...). Reference peaks can be identified with or without 
forcing. 

 

The forcing peaks not defined as reference peaks are then identified. 

 

The remaining peaks are then identified globally. After setting the score for each peak in each window, the 
program calculates all possible combinations according to the peaks order, including this of the peaks already 
identified. 
The program then retains the combination with the highest score (sum of individual scores). 

9.3 Calibration 

Soprane CDS offers several calibration possibilities: 
- Manual calibration 

- Calibration by reprocessing 

- Automatic calibration 

- Calibration via the Launch menu 

 
The Configuration application              is used to define the total number of streams as well as the number of 
calibration streams. 
 
 
1. Manual calibration 

 

Manual calibration consists in directly modifying the response coefficients of the method by the processing 
module. It is therefore sufficient to start the processing interface, to load an analysis carried out on the 
standard gas and to load the method associated with this analysis, to select the analytical module, to select 
the display in the Calibration mode (see chapter Calibration to select the component and to directly inform 
the value of the surface. You can retrieve the value of this surface in the Results Table view (see chapter 
Analyses results). 
 
2. Calibration by reprocessing 

 

You can perform a calibration by reprocessing when you have completed a series of analyzes and verified 
that they have been correctly integrated and identified (for example, tests carried out in the case of an audit). 

 

The calibration by reprocessing is accessible in Soprane CDS in the tab "Analyses" through the menu 
"Calibration / Calibration by reprocessing".  
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First, you have to select the method to calibrate and then select the analysis files that will be used for this 
reprocessing. The button "Details" enables you to visualize the name of the sample, the type of analysis and 
the calibrated level in the case of a calibration. 

 

 
 

For each analysis, the software asks you what type of action you want to achieve and on what level. 

 

There are 4 types of action for the calibration: 
- Replace : the response coefficients stored in the method are replaced by the coefficients calculated 

during this analysis. 
- Average: the software calculates an average between the response coefficients stored in the 

method and those obtained during this analysis. The result of this average is then stored in the 
method. (Arithmetic average). 

- Weighted: the software calculates an average between the response coefficients stored in the 
method and those obtained during this analysis by weighing less the old coefficients. The result of 
this average is then stored in the method. (Geometric average). 

- Blank: no modification of the response coefficients is done. This type of analysis is used to purge 
the lines or to perform the calibration checks without modifying the method. 

 
To start the calibration by reprocessing, just click on the Confirm button. 

 

You can then view the calibration report if you select a single analysis, right click, and select the "Report > 
Calibration report" menu. 
The method is saved automatically. 

 

As far as it is possible and to verify the results before modifying the method, we recommend this method. 

 

3. Automatic calibration 

 

We have indicated in chapter Managing analysis sequences how to define an analysis sequence. In the same 
way, it is possible to define a calibration sequence (see chapter Managing calibration sequences). This type 
of calibration is mainly used when the instrument is equipped with a stream selector. 
 
The calibration can be automatically triggered, and its programming has priority on the course of the analyses 
sequence. 
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A first sub-menu "Calibration" is used to define the calibration sequence in the same way as we have defined 
an analysis sequence. 
The sub-menu "Calibration / Programming a calibration" is used to define an automatic calibration request 
and, in this case, the frequency of calibrations (see chapter Programming a calibration). 
 
If automatic calibration is chosen, it is necessary to define the date and time of the first calibration, then the 
number of days (0-999) before a new automatic calibration. 
The value 0 day between 2 calibrations is used to impose only one automatic calibration.  
 
CAUTION: Calibration is only initiated when the analyzer is in operation, in automatic mode. 
 
4. Calibration via the Launch menu 

 

When you have defined a calibration sequence, you can launch this sequence directly from the "Start" menu. 
This solution is interesting especially if the standard selection is not automatic and thus manual. 

 

5. Calibration levels 

 

It often happens that the standard cylinders used do not contain all the components and, in this case, it is 
necessary to use several cylinders to calibrate all the compounds of the method. 
 
If all the standard concentrations of these different cylinders are mentioned as level 1, most probably you 
will encounter calibration problems because, if one of the compounds is not present in a cylinder and for 
some reason has an artifact or a baseline drift which causes a peak to be detected at the expected time of 
this compound, the area of this peak will replace the standard area of this compound which will distort its 
calibration. To overcome this problem, the software offers the possibility of using several calibration levels. 
Thus, for a cylinder, it will be necessary to use one level of calibration and for another cylinder, it will be 
necessary to use a second level. The selection of the level will be done by the option "used" which must be 
checked according to the level entered. 

 

Generally: 1 Level = 1 cylinder 

 

The calibration history can be viewed (see chapter Logs menu). 
 

9.3.1 Principle of calibration 

Chromatography is an analytical technique that proceeds by comparison: a known quantity of a product is 
analyzed, and the area or height of the corresponding peak is measured. When an unknown quantity of the 
same product is analyzed, the opposite operation is performed: the surface or height of the peak is measured, 
and the quantity is deduced. 

 

The main question is therefore to know how the detector behaves when a constituent goes through it. 

 

The TCD (Thermal Conductivity Detector), or μTCD in the case of μGC, offers the advantage of being a very 
linear detector over a wide concentration range. 

 

The FID (Flame Ionization Detector) remains a detector whose response is linear but over a more restricted 
concentration range. 

 

In many cases, the detector response can be assimilated to a straight line passing through the origin. It will 
sometimes be necessary to consider that the answer is a straight line that does not pass through the origin 
or that it is a curve. 
It will always be preferable to use one or more standards whose concentration(s) are close to the quantity 



SOPRANE CDS User manual for MicroGC – Version 2.1 

 

 
Page 106 / 138 

that we want to analyze. 
 

9.3.2 Choice of a response curve 

One or several standards are required to calibrate an analyzer and a given standard may not contain all the 
constituents analyzed on an instrument. 
Soprane CDS proposes "calibration levels" and a calculation method will have to define all the usable levels, 
specifying for each constituent whether it is present or not at a given level, and if so, in which amount. 
For a given constituent, a calibration sequence will have to use a minimum number of levels used, function 
of the equation desired for the response curve. 
One point is required to define a straight line passing through the origin, 2 points to define any straight line, 
and so on. 
A number of points higher than the minimum will improve the response with a search for the optimal curve 
according to a process to be defined. 
The equation of the response curve given by Soprane CDS always represents the area or height of the peak 
expressed as a function of the concentration. 
 
Straight line passing though the origin: 
There is only one unknown and only one standard level is required. 

 

Straight line not passing through the origin: 
There are 2 unknowns, and two levels are necessary. 

 

Straight line not passing through the origin but with a straight line passing through the origin for the 
concentration values lower than the lowest concentration used during the calibration: 
There are 2 unknowns, and two levels are required. 

 

Quadratic (curve of degree 2): 
There are 3 unknowns, and three levels are required. 

 

Cubic (curve of degree 3): 
There are 4 unknowns, and four levels are required. 
 
Curve of degree 4: 
There are 5 unknowns, and five levels are required. 

 

Exponential: 
There are 2 unknowns, and two levels are necessary. 

 

Logarithmic: 
There are 2 unknowns, and two levels are necessary. 
 
Optimization of the response: 
If, for a given constituent, we use a number of levels greater than the minimum number required, Soprane 
CDS will use all the points and will define the optimal response by applying the least squares method. 
The user has the choice to define the variable to be used for this optimization. 
La correction est définie par : 

• Equal: the importance of the points is the same, 

• Quantity: the importance of the points is proportional to the quantity of product, 

• Inverted quantity: the importance of the points is inversely proportional to the quantity of product, 

• Square quantity: the importance of the points is proportional to the square of the quantity of product, 

• Inverted square quantity: the importance of the points is inversely proportional to the square of the 
quantity of product, 
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• Logarithm of the quantity: the importance of the points is proportional to the logarithm of the quantity 
of product, 

• Logarithm of the inverted quantity: the importance of the points is inversely proportional to the 
logarithm of the quantity of product, 

• Logarithm of the squared quantity: the importance of the points is proportional to the square of the 
logarithm of the quantity of product, 

• Logarithm of the inverted squared quantity: the importance of the points is inversely proportional to the 
square of the logarithm of the quantity of product. 

 

9.3.3 Rejection of calibration 

The calibration of an analyzer can have serious consequences, especially if it is calibration performed 
automatically. Soprane CDS therefore provides the possibility to validate a minimum of things and, possibly, 
to reject the calibration of one or more constituents. 

 

Generally, a calibration sequence uses several measurements carried out on one or several standards. 
For each analysis of each standard (Soprane CDS proposes calibration levels, used or not for a given 
constituent, to define the standards), it is possible to specify how the result of the measurement should be 
used. 
Each measure can be described as: 

• Blank: The analysis is defined as a blank to be ignored. This enables to rinse and wait for stabilization after 
passing through a new standard. 

• Replace: This analysis replaces everything known for this level and is therefore the first measure of a 
possible series that will be averaged. 

• Average: This analysis is used to average the known data for this level, so that each measure keeps the 
same importance. 

• Weighted: This analysis is used to average the known data for this level, so that each analysis counts as 
much as all previous ones. 

 

When performing an automatic calibration (launching a calibration sequence) or a calibration by reprocessing 
several stored analyses, a process is imposed that will enable response equations to be calculated only when 
the last analysis of the last level has been processed. It is only at this stage that Soprane CDS will consider 
checking, constituent by constituent, the validity of the calibration according to the maximum deviation given 
by the user for this constituent. 

 

4 cases are possible: 

• The maximum permissible variation is 0 %. A zero deviation has no meaning, but this 0 % deviation value 
indicates that no validation of the results is required. This value is to be used when the method has never 
been calibrated or when it is known that the previous calibration cannot be a reliable reference. 

• The maximum permissible variation is x % and the difference between the calibration result and the data 
stored during the previous calibration is below x %. The calibration of this constituent is validated. The 
previous data is lost and replaced by the calibration data that has just been performed. 

• The maximum permissible variation is x %, the difference between the calibration result and the data 
stored during the previous calibration is greater than x % and the standard amounts present at the levels 
for which this "defect" is observed are not the same as during the previous calibration (amount variation 
greater than 1 %). There is no evidence of a lack of reproducibility, but the question can be asked. Soprane 
CDS accepts this constituent calibration but reports the problem so that the user can re-calibrate if 
necessary. 

• The maximum permissible variation is x%, the difference between the calibration result and the data 
stored during the previous calibration is greater than x% and the standard amounts present at the levels 
for which this "defect" is observed are the same as during the previous calibration. The variation in 
response is abnormal and Soprane CDS rejects the calibration. Rejection is reported and Soprane CDS 
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keeps on working with the previous calibration values. 

 

Another validity check is then carried out to confirm that the response curve of each constituent is an 
increasing function. 
Soprane CDS therefore performs, when necessary, a verification of this growth between the minimum and 
maximum concentration values used to carry out the calibration but also between zero and the lowest 
concentration value or between the highest concentration value and 10 times this value. A possible defect, 
whose probability is extremely low, will be reported but will not result in the calibration rejection. 
 

See also chapters Reference calibration and Calibration report. 
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10. Appendix III: Integration guide 
This appendix describes a standardized workflow for the integration of chromatograms with Soprane CDS. 

10.1 Accessing the integration menu 

To access the integration menu, click on the Process tab in the left-hand menu in Soprane CDS. 

10.2 Selection of the processing method 

Click on Method > Load a method. Then select the appropriate method. 
 

 
 

10.3 Integration configuration 

In the Integration > Process configuration menu, make sure Version used is V2 with 
DiscreteWaveletTransform smoothing. 
 
 

 
 

10.4 Selection of the analysis 

Analyses used to define integration parameters must be representative of future analyses processed with 
this method (similar sample, similar analytes). 
 
In the top middle menu, first choose the series and then the analysis number. Validate.  
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10.5 Integration flow 

1. Peak detection – define regions of interest in the chromatogram 

2. Minimal height and area rejects – remove small and irrelevant peaks 

3. Peak start and stop slopes – adjust peak integration 

4. For coeluted peaks: 

a. Tangential skim  

b. Force baseline for all valleys  

10.6 Integration parameters 

10.6.1 Integration parameter times 

Each integration parameter is effective once it has been defined in the parameters table. It remains active 
until the end of the chromatogram or when the same integration parameter is used again at a later time. 
 

10.6.2 Peak detection 

This parameter defines regions to be considered for integration.  

• if peak detection is unticked, no peak will be integrated after the time set for the parameter. 

• If peak detection is ticked, the integration engine will look for peaks after the set time.  

 
Example :  
 
In the chromatogram below, the matrix peak elutes at 20 sec. After 67 sec, the backflush causes baselines 
fluctuation.  
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Considering the matrix peak does not require integration and no peak elutes in the backflush interference, 
we can exclude these regions from integration. 
 
Integration parameters: 

 No integration after 0 sec 

 Integration of peaks possible after 23 sec 

 No integration after 67 sec 

 
 
Resulting Chromatogram: 
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10.6.3 Minimal height and area rejects 

Minimal height and area reject parameters remove peaks smaller in area or height according to the criteria 
defined with the parameters. Placing the mouse cursor on a peak will display its height and area (see below). 
Comparison of the areas and heights of real peaks with false-positive peaks are generally used to define 
minimal height and area rejects. 
 

 

Important notes:  

• It is important not to be too restrictive when setting minimal rejects. Future analyses may include 
compounds at smaller concentrations than the analysis used to define minimal areas and heights. 

• In case of large integrated interferences, it is preferable to use height rather than area reject. 

 

Example :  

In the chromatogram above, two false positives are integrated along with actual peaks.  

Retention time (s) Peak or Interference Area mV.s Height mV 

31.51 Peak 163.8 352.6 

32.89 Interference 0.0 0.23 

47.49 Interference 42.4 3.07 

60.91 Peak with coelution 256.3 188.5 

 

Integration parameters: 

 All peaks smaller than 5 mV are removed 

 All peaks smaller than 10 mV.s are removed 
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Resulting chromatograms: 

  

 

10.6.4 Peak start and peak stop slopes 

In occasional situations, peak integration may start/stop too early or too late. Peak start slope and peak stop 
slope are used to adjust it.  
 
Five possible situations:  
 

1 Peak is well integrated Leave peak start and stop slopes as they are 

2 Peak integration starts too early Increase peak start slope value 

3 Peak integration starts too late Decrease peak start slope value 

4 Peak integration stops too early Increase peak stop slope value 

5 Peak integration stops too late Decrease peak stop slope value 

 
 
Examples : 
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By adjusting the peak stop slope from 50 to 1 mV/s, the peak integration is improved. 
 

  
 
Important notes: The same values of peak start slope, and peak stop slope may not work for all the peaks in 
the chromatogram. These parameters can be used multiple times with different set times, so that each peak 
is integrated with appropriate parameters.  
 

10.6.5 Apex 

We had a signal with small fluctuations at the top of the peak. 
 

• The derivative signal (in red) crosses 0. 
• No peak detected.... 
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By setting an apex value above the derivative fluctuations (2500), the peak is correctly integrated: 
 

 

 

 
 

 

10.6.6 Specific parameters for coelution 

 

a) Force baseline for all valleys 

OFF ON 

  

 

b) Tangential skim 

OFF ON 

  
 

10.7 Soprane CDS update 

This guide was written with Soprane CDS version 3.0.353. If you are running an older version, you can 
download the updated version from our website.  

https://www.srainstruments.com/p/soprane-ii/ 
 
 
 

https://www.srainstruments.com/p/soprane-ii/
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11. Appendix IV: Setting the backflush time 

11.1 What is the backflush ? 

When developing the method, an important step is to set the backflush time. The main goal of the backflush 
system is to protect the analytical column. The most common situation where the backflush system is 
encountered is when using a Molsieve 5Å column (MS5A). This will be the only case discussed in this chapter. 

 

The Molsieve 5Å column is dedicated to the analysis of permanent gases (He, H2, Ar/O2, N2, CH4 and CO). If 
heavier compounds are injected into the MS5A column, the stationary phase will lose its efficiency and its 
separation power will decrease rapidly. To protect this column against heavy compounds, in particular CO2, 
H2O and H2S, a pre-column is installed between the injector and the analytical column (MS5A).  

 

After the injection, there are two steps: 

 

- "Foreflush" mode: the carrier gas passes through the injector, then the pre-column and finally 
through the analytical column. 

- "Backflush" mode: the carrier gas arrives between the pre-column and the analytical column. 

 

During the "fore flush" mode, the molecules of the sample are injected into the pre-column where a first 
separation takes place. The light compounds not retained thus not separated (He, H2, Ar/O2, CO) leave the 
pre-column first, followed immediately thereafter by CH4. Only then the heavy compounds go out.  

 

When the "backflush" mode is activated, the compounds that have had time to exit the pre-column continue 
their way to the detector and are separated in the analytical column. Compounds that are still in the pre-
column are backflushed. 
 
A well-adjusted backflush time is a backflush time that is long enough to let pass all compounds of interest 
(He, H2, Ar/O2, N2, CH4 and CO) and short enough to backflush heavy compounds that could damage the 
analytical column. 
 

11.2 How to adjust the backflush time with Soprane CDS ? 

!  Important note:  

 

The backflush time must be adjusted after defining the temperature, carrier gas pressure and injection 
time. If one of these parameters is changed, the backflush time must be adjusted again. 

 

A dedicated tool has been developed to help the customer adjust the backflush time.  

 

1. Open " SRA.Soprane.BackflushMethodGenerator.exe" in "C:\Soprane II". 
2. Select the analyzer and click on "Load a method": 
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3. Select the analytical method to develop: 
 

 
 

4. Select an initial and a final backflush time for the channels equipped with a backflush system.  
5. Select the number of methods to run. For a first estimation, try to have a step of 1 second between 

two backflush times (for example: initial backflush time = 5 seconds, final backflush time = 
10 seconds, method run = 6).  

6. Define a name for the series of analyses.  

7. Click on              to automatically generate methods with different backflush times. 
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8. Click on             to automatically create a sequence of analysis with one analysis for each method 
previously generated.  

9. Give a name to this sequence and click on  
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10. Connect a standard containing CH4 to the MicroGC, open Soprane CDS, click on "Start" and launch 
the previously generated sequence (see chapter Starting a sequence): 

 

After a few minutes, you will obtain chromatograms with different backflush times: 

 

11. Open them one by one in Process, place your mouse on the peak of CH4 and record its area:  
12. In an Excel file, write the area of peak of CH4 in function of the backflush time and draw the 

corresponding curve: 
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13. Adjust the backflush time precisely at more or less 0.1 second.  
14. Apply the same method as previously but create a sequence with a step of 0.1 second. For the 

previous example, start at 26 seconds and finish at 28 seconds with a step of 0.1 second. 
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12. Appendix V: Filtering Data 

12.1 Automatic filtering 

Most of the tables in Soprane CDS have the ability to filter columns directly at the table level like an Excel 
spreadsheet. 

 

 

12.2 Customized filtering 

Customized filtering represents a row in which values can be entered to filter the items in the corresponding 
columns. 
When a single value is entered in a cell, the elements of the corresponding column are filtered according to 
the filtering criterion. 
 
For example, in the following table, only the series of analyzes containing the "Air" field are displayed. 
 

 
 
The filter criterion can be indicated by preceding the value with the desired operator (see table below). 
 

• Relational Filtering Criteria 

 

Symbol Description Example 

 <> Filters the items to display only those that are different 
from the specified value.  

<>Test 

 *(Operator precedes value) Filters the items to display only those that end with the 
specified value. 

Test* 

 = Filters the items to display only those that are equal to 
the specified value.   

=Test 

 > Filters the items to display only those that are greater 
than the specified value.   

> 50 
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 >= Filters the items to display only those that are greater 
than or equal to the specified value.   

>=50 

 < Filters the items to display only those that are inferior to 
the specified value.   

<50 

 <= Filters the items to display only those that are inferior or 
equal to the specified value.   

<=50 

 *(Followed by a value) Filters the items to display only those that start with the 
specified value.   

*Test 

 
For example, if 5 is specified as a filter, all elements in the column (assuming that the column contains 
numeric data) will be automatically filtered to display only those with a value of 5. If all values are lower than 
5, the lower operator must precede the filter value: <5. In addition, to filter items that begin with a given 
string, use the * key preceded by a value (for example, [value *]); to filter items that end with this value, use 
the * key followed by a value (for example, [* value]). 
 
The following example shows how to display only the series "16020402_Air", simply add "=". 
 

 
 
 

• Conditional filters 
 

Filter Description Example 

 AND Includes all data according to the AND [Hello AND world] 

 NOT Excludes all data according to NOT [NOT 5] 

 OR Includes all data according to OR [Hello OR Goodbye] 

 
The items in a column can be filtered according to more than one value by separating those values with the 
AND or OR conditional operators. These operators, which must be in uppercase, are used in conjunction with 
both relational and conditional filters. 
For example, to filter string items which include both words [Hello] and [world], the words would need to be 
separated by the AND operator: [Hello AND world]. 
 
The NOT conditional operator can also be used to exclude a specific value. 
For example, to exclude only the value [5], [NOT 5] can be specified as the filter criterion. If more than one 
value is to be excluded, then the NOT operator must precede both values.  
For example, [NOT 5 AND NOT 7] will include all values except 5 and 7. 

 

Note : With the exception of conditional operators (i.e., AND, NOT, OR), any extra white space preceding or 
following an operator will be automatically trimmed. 

 

 

As another general example, the following table contains two filters. 
The first is in the Serie column, which displays only the series containing the "Analysis" or "BF 4.5" field. The 
second filter is at the column Pic0 (A) which only displays values lower than 30. 
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13. Appendix VI: Exporting Data 
In the large majority of tables, the data can be exported at any time. 
 

The following buttons  can be used for different types of exports. 
 

•  : Exports data in an exploitable format by Excel, CSV, or a printable file 

•  : Copies the table in the clipboard in image format. 

•  : Copies the table values in the clipboard. 

• : Proposes a print preview and prints the results if desired. 

• : Displays a configuration window for the corresponding table. 
 

13.1 Exporting to Excel 

By clicking on the button          , a window opens and proposes a list of formats to be exported, choose Excel. 
 

 
 

13.2 Exporting to Csv 

By clicking on the button          , a window opens and proposes a list of formats to be exported, choose CSV. 
 

 
 
An option enables to include column headers, if this option is unchecked, the columns will have no title. 
The choice of the column separator offers the following choices: 

o ; (semicolon) 
o , (Comma) 
o Tab 

 
The different types of text delimiters are double quote (") or single quote (') characters. 
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Several date formats are available: 
o Short date (day/month/year) 
o Full Date (example Tuesday, October 18, 2016) 
o Full date and short time (example Tuesday 18 October 2016 09:05) 
o Full date and long time (example Tuesday 18 October 2016 09:05:45) 
o Short date and short hour (example 18/10/2016 09:05) 
o Short date and long time (example 18/10/2016 09:05:45) 
o Month and day 
o Year and month 

 
The digital formats can be of different types: 

o General (most compact format) 
o Fixed point (full and decimal digits with an optional negative sign) 
o Scientific (Exponential) 
o Two decimals 
o Three decimals 

13.3 Exporting to Diff 

By clicking on the button          , a window opens and proposes a list of formats to be exported, choose Dif. 
 

 
 
Soprane CDS enables to save the analysis results in files directly exploitable by a spreadsheet (DIF extension). 
These files are also visible in a text editor. The fields, whose value is in ASCII, are separated by a tab and the 
analyses by a line break. 
 
If needed, this file can be generated automatically after each analysis. To do this, click on the configuration 
button, then check the box "Diff file management". 
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13.4 STARe format (compatible with a TGA) 

This format is used to create an export file of Soprane CDS emission curves in order to import it directly into 
the STARe software. This txt file needs a certain format.  
 
The first column is time. This time is the abscissa axis. Then come the different compounds of the Soprane 
CDS method. The last line is "$Columns" which corresponds to the number of columns and whose numerical 
values will be imported into STARe.  
 
Here is an example of export: 
 

 
 
Concerning the time, it is necessary to convert the injection date into TGA time which starts at zero.  

1 

2 



SOPRANE CDS User manual for MicroGC – Version 2.1 

 

 
Page 127 / 138 

14. Appendix VII: Driving a Solia from Soprane CDS 
Soprane CDS, when combined with MassHunter GC-MS Acquisition and MSD Chemstation Data Analysis, 
enables the MicroGC/MS SOLIA coupling to be controlled. 

14.1 Installation 

Communication between Soprane CDS, MassHunter and MSD Chemstation Data Analysis is carried out via 
computer macros. These macros are automatically deployed in the MassHunter and MSD Chemstation Data 
Analysis tree structure when Soprane CDS is installed. It is therefore necessary to install Agilent software 
before installing Soprane CDS.  
Install in this order: MassHunter GC-MS Acquisition, MSD Chemstation Data Analysis (MassHunter version) 
and then Soprane CDS as administrator and following the recommended settings. 

14.2 Instrument configuration 

14.2.1 Creating the Solia instrument in Soprane CDS 

 

 
 

From Soprane Configurator, create a new analyzer by clicking on the "+" icon. Then enter the IP address of 
the instrument. Select "COM2" for the Solia category (as shown in the image above).  
 

14.2.2 Creating the MSD instrument in Agilent GCMS Configuration 

 

 Start Agilent GCMS Configuration as an administrator 

 Select the instrument number to be configured (default is "1") 

 Fill in the name of the instrument (for example "MSD") and the identity (ID) of the laboratory 
(optional) 

 Select the MSD model  
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 Enter the IP address of the MSD. The IP address of the instrument is displayed on the screen inside 
the top cover of the MSD. 

 Specify the polarity of the quadrupole in "DC Polarity". This information is located inside the top 
cover ("Pos" or "Neg")  

 Select "None" for the GC model 

 Select "Workflow mode: Enhanced"  

14.3 Configuration of the coupling 

In order to drive the coupling, it is necessary to configure the coupling in each of the software packages. In 
Soprane CDS, the activation of the coupling is done from the "option" tab and then "coupling". 
 

 
 
 
A window will then open. Select "Solia" and then the name of the MS instrument created in the Agilent GCMS 
configurator, as below: 
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In MassHunter, check the line "Use MSD ChemStation Data Analysis" in the "Method" menu. 
 

 

14.4 Controlling the Solia 

Once these configuration requirements have been completed, it is possible to control the channel selection 
valve between the µGC modules and the MS detector. There are several ways to change the position of this 
valve.  
From the "Status" tab, by clicking on the bar above the diagram: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



SOPRANE CDS User manual for MicroGC – Version 2.1 

 

 
Page 130 / 138 

 
 

The names of the different modules are displayed on the screen. Click on the module to be coupled to the 
MS detector. 

 
When starting analyses, in the "Start" tab: 
 

 
 

When writing an analysis sequence: the valve position will change between the analyses and during the 
sequence, in order to couple the desired µGC module to the MS detector for each analysis: 

 



SOPRANE CDS User manual for MicroGC – Version 2.1 

 

 
Page 131 / 138 

 
 

14.4.1 Creating an analysis method 

A Solia analysis method includes a Soprane analysis method and a MassHunter analysis method.   
 

14.4.2 Creating a Soprane CDS analysis method 

Refer to Chapter Managing methods 
 

14.4.3 Creating a MassHunter analysis method  

From the "File" tab, save the method under the desired name. Then edit the method. 
 
Check all three boxes : 
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Check "Data Acquisition" and "Data Analysis": 
 

 
 
 
Select "Sample Inlet: Other/None" and "Injection Source: External Device". 
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Define MS parameters : 
 

 
 
SRA recommends the above default settings, which should be modified according to the application. The 
Run Time must be equal to or greater than the Soprane CDS analysis time.  
 
 
Check "Quant Report" (essential for the transmission of results to Soprane CDS) and save the method. 
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14.5 Results processing 

Soprane CDS offers the possibility to combine all µGC (TCD detection) and MS results in a same table, as 
shown below. 
 
 
 
 
 

 
 
The table above groups the TCD results of the µGC modules (indicated by the letters (A), (B) and (C)), as well 
as the MSD results.  

 

14.5.1 Creating a Soprane CDS processing method  

 Refer to chapter Process 
 

14.5.2 Creating an MSD Chemstation Data Analysis processing method 

Open MSD Chemstation Data Analysis and load the acquisition method used. The processing method must 
be the same as the acquisition method for the results to be transmitted to Soprane CDS.  
 
In the "Solia Coupling" tab of MSD Chemstation Data Analysis, click on "Add Custom macro in method". 
 

 
 
 
 
 

µGC results MSD results 
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From the "Chromatogram" tab, click on "AutoIntegrate" and then modify the integration parameters in "MS 
Signal Integration parameters" if necessary. Then save the integration parameters under the desired name: 
 

 
 

From the Calibration tab, click on "Set Up Quantitation". 
 

 
 

 
Fill in the fields "Calibration Title", "Integration Parameter File" (click on browse and load the previously saved 
integration file) and "Units of concentration". Uncheck "Use RTEINT" and click on OK. 
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The following window is used to add the desired compounds to the calibration table. Click on "Insert Above"  

".  
 
Right double-click on the chromatographic peak’s apex to be added to define its retention time in the 
calibration. Define the name of the compound. 

 

 
 
At this stage, it is also possible to select target ions used for quantification. To do this, click simultaneously 
on the left click and right click on the m/z peak of the mass spectrum to be considered. 
 
 
Click on "Save" to move to the next compound, and on "Exit" when all the compounds have been added to 
the table.  
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Fill in the fields "Compound concentration" and "New Level ID". 
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The window below then opens, summarizing all the calibration parameters by compound. The concentration 
of each compound can be modified by level from the "Calibration" tab. 
 

 
 
Click on "OK" and save the method from the "Method" tab. 
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